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Introduction

Why new Standards?

The last comprehensive release of CAD Standards by Maryland State Highway Administration was in
1995. At that time, the CAD Standards could be used for virtually any version of Bentley’s MicroStation
software. Also, the 1995 release of the CAD standards was not all inclusive.

However, the release of MicroStation V8 in early 2002 brought with it a change in MicroStation’s file
format as well as tighter integration with other products that have been adopted by Maryland State
Highway (ProjectWise, IPLOT). To fully take advantage of the new functionality within MicroStation V8, a
change in the CAD Standards was crucial. The IDS Team took on the task of developing the new CAD
Standards and tools to better target the workflow used by Maryland State Highway.

About This Course

This course will provide you with the fundamental information you need to use Maryland State Highway's
V8 CAD Standards: First Edition within MicroStation V8.

This courseware has been designed to emulate the progression of design projects with a very simple
workflow in mind. This workflow serves as a reference more than a guideline. It teaches concepts and
procedures by walking you through common project tasks in MicroStation V8 using the CAD Standards. It
breaks the tasks up into short, easy to understand segments. Training classes using this courseware can
combine hands-on learning, visual aids and lecture.

Course Objectives

When you complete this course, you will understand the following:
e New features in MicroStation V8

e How the new V8 features relate to the MDSHA CAD Standards
e How to use Bar Menu to place MicroStation elements
e How to compose a display

e How to plot a display

Before You Begin

Before beginning this course, we recommend that you have a working knowledge of MicroStation J.
Although not necessary, familiarity with the 95 Standards is not required, it may be helpful. We
appreciate the comments from you and will incorporate those comments in the future releases of this
courseware.

This class is NOT intended for new MicroStation users.

Conventions in This Courseware
The following conventions are used throughout this courseware.

Lessons

Each chapter of this courseware is a lesson. A lesson describes a general area of MicroStation V8 as it
relates to Maryland State Highway Administration and the CAD Standards. Generally, the chapters focus
on a few areas of a design process using related MicroStation and CAD Standard features. A lesson in

004 " DS

Integrated Design System



Introduction

the courseware is made up of tasks — each task relates to a series of MicroStation commands. The
number of tasks varies from lesson to lesson.

Hands On Exercises

Each lesson may contain several individual hands on exercises, which are written in a sequential format
to mimic the operational procedures. It contains numbered steps that list specific instructions, such as
words to type, specific keys to press, or commands to choose from the menus. The instructions are
followed by comments describing what is happening in the program, reasons for the results you see, and
pictures to help you identify certain elements of MicroStation, such as toolbar, buttons, dialog boxes or
forms.

Note: Notes point out special details that you should consider.

Important: Important notes point out details which, if ignored, could seriously adversely affect your
use of MicroStation V8.

A Cool Tool: Cool Tools point out powerful MicroStation features that make your work easier.

Typographic Conventions
This courseware uses the following typographic conventions:

e Tahoma Bold type indicates the names of most elements of the user interface, such as
windows, dialogs, fields, rows, features, and Wizards.

e Tahoma Bold Italic type indicates specific information you enter in to fields.
e SMALL CAPS indicate the names of keyboard keys, such as TAB or CTRL.
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Chapter 1: Overview of V8 Functionality

Lesson Objectives

In this lesson, you will learn about some of the new functionality included in MicroStation V8. The topics
are covered as follows:

e Introduction to MicroStation V8
e DGN File Format
e  AutoCAD Compatibility

e Models
e Cells
e Levels

e DGN Libraries

e Text and Dimension Styles
e Design History

e Raster Manager

e Workmodes

¢ New Interface and Tool Enhancements

Introduction to MicroStation V8

MicroStation V8 is considered a major upgrade compared to previous releases of the MicroStation
software. One of the most substantial improvements is the redesign of the MicroStation file format. This
change in file format not only eliminates constraints placed on users in older versions, but also allows
better compatibility with AutoCAD.

Although there are many changes in functionality and tools in MicroStation V8, we will briefly cover the
most significant changes. Any changes that greatly affect the use of SHA’s CAD Standards will be covered
in more detail later in the guide.

Important: This training guide covers MicroStation functionality up to and including V8.01.02.15.

DGN File Format

Previous versions of MicroStation had various limitations placed on a MicroStation file.

Whereas in earlier versions the user had to always be concerned about the size of the MicroStation
design plane, now the design cube is defined using double precision coordinates. This means the design
plane within a MicroStation V8 file is greatly expanded in size (about two million times larger in each
direction), which should resolve most “Element outside design plane” errors.

The redesign of the DGN file format also decreases the actual file size of MicroStation files, MicroStation
files generally take up less disk space than the same file in V7 format.

The expanded design cube also allows larger MicroStation elements; vertices of an element are no longer
limited to 101, this has been expanded to 5000 in MicroStation V8. This also affects fence clipping when
attaching reference files. Many more clipping masks may be defined in V8.

1-1
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Chapter 1: Overview of V8 Functionality

All V7 DGN files must be converted to the V8 format before they can be edited in MicroStation V8. This
can be done individually, or in batch mode.

Important: Once a file has been converted to V8, the file cannot be reopened in MicroStation J
unless the file is converted to V7 format. New functionality in MicroStation V8 will not be
converted back to the V7 version of the file. This could result in “lost” elements.

Although V7 files must be converted in order to be edited in V8, V7 files may be referenced into V8 files
without conversion. Additionally, 3D files may now be referenced into 2D design files.

The new file format also allows the DGN file size to be larger. The design file size was limited to 32 Mb in
MicroStation J. While the V7 file size limit did not affect most MicroStation drawings, files using Civil
Application software such as InRoads or GEOPAK were many times affected by this limitation (typically
when visualizing DTMs and Cross Sections). The maximum physical size of the DGN file is limited only by
the operating system (for example, the Windows NT file size limit is 4 GB).

AutoCAD Compatibility

AutoCAD files may now be opened, edited, saved and referenced in the native AutoCAD format. Paper
space and model space are supported, as well as the ability to access AutoCad blocks and fonts without
conversion.

Models

MicroStation V8 introduces the concept of models. A DGN file is now made up of one or more models
(think of models as element “containers” within a MicroStation file). A DGN file can have an unlimited
number of models, each with its own name, working units and 8 views.

Note: Whereas each model in a DGN file may have its own unit system, levels are DGN file specific, not
model specific.

There are two types of models that can be created.
e Design models can be either 2D or 3D and consists of design geometry.

¢ Sheet models are used to attach references for composing drawings.

Cells

Cell sizes are unlimited in the MicroStation V8 DGN file format and the length of a cell name has been
expanded to approximately 500 characters.

Cells are now stored as models in a DGN file. Therefore, a cell library may be opened in MicroStation and
edited; just as any other MicroStation element is edited.

After placing a cell in a drawing, the text in an unshared cell may be edited. This may replace the need
for Enter Data Fields within cells.

2D and 3D cells may now reside in the same library and there is no longer a restriction on placing 3D
cells in a 2D file.

Just like V7 DGN files, V7 cell libraries must be converted to V8 format before they may be used in a
MicroStation V8 session.

1-2
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Levels

In the MicroStation V8 DGN file format, the number of levels is unlimited, and the minimum number of
levels is 1 (named Default).

Unused levels may be deleted out of a DGN file.

All levels are named and have default colors, line weights, and line styles, providing the foundation for
numerous enhancements, one being the ability to place elements ByLevel.

The concept of V7 Level Symbology has been expanded with the introduction of Level Overrides.
Overrides now allow you to set level symbology PER LEVEL.

Perhaps the most important benefit of the new level system is that it is much easier to standardize level
structures across DGN files.

DGN Libraries

DGN Libraries are DGN files that contain levels, text styles and dimension styles. They are designed to be
a portable container for CAD Standards.

DGN libraries may be used as a “seed file” or attached to an existing DGN file.

A DGN file may have multiple DGN Libraries attached. These libraries can be attached manually or via
workspace configuration variables.

Text and Dimension Styles

Text and dimension settings may now be saved by [style] name and shared corporate-wide via DGN and
DGNLIB files.

Text and dimension elements that use styles are automatically updated if the style is edited.

“Parent” and “Child” styles may be used to account for slight variations in a similar set of text or
dimension settings.

Design History

The Design History feature of MicroStation V8 enables you to restore revisions of a DGN file. A revision
can be a milestone in the development of a design. When you create a revision, Design History captures
the state of the DGN file at that moment. To document the revision, Design History records your user ID
and the current time and date, and allows you to enter a comment.

=i
% a5 s B0 75 @@

Revizion | File [ate | Authar | Diescription

1.1 Mhd-0001-md43 . dogn 2003/ 2/16 1238 barbara.henry Fevized Pond #1
1.2 thd-0001-md43.dgn 200312461257 babara.heny FRemoved parking area on west side of Building 103
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Design History is an optional feature of MicroStation V8. When enabled, Design History stores historical
information inside the DGN file. When you initialize a DGN file's Design History, the file grows to record a
snapshot of the design. As you add revisions, the file continues to grow to hold the deltas.

Raster Manager
Raster Manager is used to control the display of one or more raster images in a design file view.

Raster Manager replaces both the Image Manager and Raster Reference dialog boxes from V7. Image
Manager projects may be imported into Raster Manager.

Workmodes

MicroStation V8 includes 3 different workmodes to ensure compatibility with V7 files and AutoCAD files.
e DGN Workmode enables all V8 functionality.
¢ DWG Workmode disables any V8 functionality that is not compatible with DWG and DXF files.
e V7 Workmode disables all V8 functionality that is not compatible with V7 files.

New Interface and Tool Enhancements
Many new interface and tool enhancements are included in MicroStation V8.
Below is a list of some of the major changes:

e File preview in the MicroStation Manager

¢ New Element Attribute dialog

e Message Center in the status bar

e Place arc in either direction

e Automatic visual element identification

e Scale and rotate elements About Center

¢ New hatching and patterning enhancements

e AccuSnap

Hands on Exercise: Exploring the V8 Interface

In this exercise, we will take a few moments to explore the V8 interface. Although there are many
changes in the interface and tools, we will only look at a few since our main focus is on the way SHA is
implementing V8 with the new CAD Standards.

Launch MicroStation V8
1. Double-click the MicroStation (CADSTD) icon on the desktop.

MicroStation
(CADSTD)
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2. At the MicroStation Manager dialog, click on the selection under List Files of Type.
Additional file types have been added, particularly CAD Files (DGN, DWG and DXF) and
Cell Files.

A Cool Tool: Notice in the MicroStation Manager dialog the Show File Icons toggle. Checking the
toggle changes the file view so that each file name also has its corresponding icon. Now
at a glance, the user can differentiate V7 files from V8 files.

Lizt Filez of Type:
CAD Files [*.dgn.” dwa.® duf] - |

r Head Ll
[ Show File lcons

3. Open the design file C:\Training\Chapter1\xBL-0000_training.dgn

This is the SHA border sheet file which we will discuss in more detail later in the course. At this point we
are just accessing this file to get familiar with the V8 interface.

Note: Although the MDSHA IDS Main Menu will load when the MicroStation file is opened, we are going
to ignore the menu at this point.

“"New” Tool Bars

In MicroStation V8, a few of the toolboxes have been renamed and may look a bit different than they did
in V7.

1. Notice the toolbox below the pull down menus. This is the Attributes toolbox.

[ SO0~ =0 o o - | E—
Level Filters Level Name Color Style Weight Preview

2. Notice the new Primary toolbox.

BEEacO e

Tools on the Primary toolbox are from left to right; Models, References, Raster Manager, Level
Manager, Level Display, Element Information, Toggle AccuDraw, PopSet.

A Cool Tool: V8 toolboxes respond to a right mouse click. This allows the user to quickly “customize”
the contents of a particular toolbox.

3. Right click on the Primary toolbox.

1-5
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|
H <[V Modsl

v References
IT Raster Manager
IT Lewel Manager
IT Level Display
IT Elernent Information
IT Toggle Accubraw

IT PopSet

Sk Al
List...

4. Uncheck the Models option. Since SHA is not currently calling for the use of Models,
we're going to turn that off for now.

Notice that the icon disappears from the Primary toolbox.

A Cool Tool: After right-clicking a toolbox, the List... option will allow the user to toggle multiple tools
on and off in one shot.

Using View Groups
Notice the new View Groups dialog to the bottom left of the screen.

JIEj Default ;I‘ [ |ﬂ|2|3|4|5|5|?|3|

A view group is a named collection of the eight MicroStation view windows which allows you to set up
your view to display different preferences including number of open view windows, window size, view
orientation, view attributes and level display. Each view group is associated with a model making it easy
to access and navigate through different models.

This example has 3 view groups; Default, Border Only and Title Block.

1. Click on the arrow next to the Default view group.

I ame bl odel I
Ej Border Orly Default

fim Default 1 Default
_ 25 Title Black Default

|5 oo Bll==[ EEOEEEE

2. Select the Border Only view group.

Notice the change in the MicroStation levels (the Index Sheet text is turned off) as well as the view
attributes (the Line Weights are turned off).

—

3. Select the Title Block view group.
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Again, notice the change in the view. The text and line weights reappear as well as a second view
window with an enlarged view of the title block.

Creating a View Group
1. Open and resize additional view windows in the configuration you would like to use.

2. In the View Groups window, click the Manage View Groups icon to invoke the
Manage View Groups dialog.

viewGrowps r
\@J\IEIEMEIEI?IEI

|Manage View Grn:nup5|

3. Click the Create View Group icon.

i

X

Create View Gru:uupl | Description | Madel |
Ej Border Orly Border w! no lineweights Default
[- Diefault DefaL group for.. & Default

[ Title Black Wiew 2 Title D efault

Cloze Apply I

4. Complete the Name and Description fields.

Create ¥iew Group

Creating
Model:  Default
Marme: | by View

Description: | My view groud]

ok I Cancel |

5. Click OK to create the new view group.

AccuSnap

AccuSnap provides tentative snap functionality, which may be used stand-alone or in combination with
AccuDraw. It provides graphical assistance — a “smart” pointer — for identifying and snapping to
elements. This automates the tentative snap process, virtually eliminating the need to press the tentative
snap button, thus reducing the number of “button presses” required during a design session.

SHA_V8_0003 1-7
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Note: The settings for AccuSnap may be adjusted or tuned off by selecting Snaps>AccuSap from
the MicroStation Settings pull down menu.

One of the features of AccuSnap is the ability to automatically identify elements. This can eliminate a
data point in certain tools. We will explore this with respect to the Delete Element tool.

We don't need the consultant logo box and text in this example so we are going to delete it.
1. Select the Delete Element tool from the main toolbox.

2. Float the mouse cursor over the PLACE CONSULTANT LOGO HERE text in the lower
left hand corner of the design file and notice that the element automatically highlights.

3. With the block highlighted, click a data point to delete the block. Notice the block
deletes immediately, no need for an “Accept” click.

4. Delete the consultant logo box in the same manner.

In this section, we will explore the automatic tentative snap capability of AccuSnap by placing a
Smartline from one corner of the border to the other.

5. Select the Place Smartline tool from the main toolbox.

6. Float the mouse over the lower left corner of the border. Notice the yellow X that
appears as the mouse gets close to the corner of the block. This is the affect of
AccuSnap. You may notice a pop up box appears to display the element type and level
the element was placed on.

B #USERNAMES

o
&

7. With the yellow X in the corner of the border, data point to begin the Smartline at the
corner of the block.

8. Move the mouse to the opposite corner of the border, data pointing when the yellow X
appears.

9. Right click to end the Smartline.

Note: In this exercise, AccuSnap is set to use the Keypoint Snap with 2 as the Keypoint Divisor.
The Snap Mode and/or Divisor may be changed as needed.

Tool Enhancement — Rotate Element
In this section, we will look at an example of a useful tool enhancement in MicroStation V8.

1. Using the MicroStation Place Block tool, place about 4 blocks within the border area.
2. Using the Element Selection tool, select the blocks you just placed.

3. Select the MicroStation Rotate Element tool.
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4. Set the Method to Active Angle and set the angle to 20.

5. Click the black arrow on the bottom right corner of the Rotate Element tool settings
window.

L]
Method: _Active Angle "’I

I 20.0000° E
I™ Copies: |1
[T UseFence  |Inside -
¥ Steteh Cells

@_

Notice there is a new option for About Element Center.
6. Toggle About Element Center ON.

Zroiate SRR

E
[~ Copies i
[T UzeFence | Inside ‘"’
¥ Siretch Cellz

F 9

v About Element Center

7. Select a data point in the MicroStation view.
Notice that each block is rotated about its own center instead of rotating about the selection set center.
8. Reset to quit the rotation.

Note: This is just one small example of tool enhancements within MicroStation V8. Many tools have

been “weighted” and the tools settings window may provide more settings by clicking the black
arrow.

9. Exit MicroStation.
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Chapter 2: SHA CAD Standards Concepts

Lesson Objectives

In this lesson, you will learn how the SHA CAD Standards are designed to be used on SHA projects. You
will become familiar with the functionality of V8 that SHA has decided to implement at this time. The
topics are covered as follows:

e SHA Standard workspace

e Workspace versioning

e File naming convention and File Naming Wizard
e Projects managed through ProjectWise

e Using MicroStation with ProjectWise and the CAD Standards
e Projects stored on a CAD Server

e File Ownership

e Seed Files

e Levels

e DGN Library

e Level Manager and Level Filters

e Cells

e Linestyles

e Scaling

e Text Styles

e Dimension Styles

e Detail Models

e Color Tables

e 3D and 2D files

SHA Standard Workspace

SHA has developed a custom workspace for use with the new CAD Standards. This workspace helps
manage the drafting environment by loading all standard files, tools and macros needed.

The SHA standard workspace has been implemented for use both within SHA and externally
(consultants).

Details on the workspace configuration itself and installation of the workspace may be found in the CAD
manual.

There are currently two workspaces delivered with the CAD Standards, one for working with MicroStation
J files and one for working with MicroStation V8 files.

The desired user workspace is selected in the MicroStation Manager once MicroStation is launched.
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YWorkzpace
ser! (ISR
FProject:  MOSHAWT
Interface: MDSHA S 01
MDSHA V7 Workspace

The MDSHA V7 workspace will allow the editing of V7 MicroStation files using the 1995 SHA CAD
Standards for MicroStation J. Using the V7 workspace is ideal for working on and viewing old projects. All
“legacy” resource files for the old standards are included in the workspace and all functionality that is not
recognized in V8 is disabled.

MDSHA V8 01 Workspace

The MDSHA V8 01 workspace will deliver the new CAD Standards for any V8 projects using the
standards.

Important: If a V7 file is opened using the MDSHA V8 01 workspace will always open as Read-
Only.

The MDSHA V8 Workspace configuration has been designed to open a V7 file as Read-Only. This
prevents a user from (1) accidentally converting a V7 file to V8 and (2) trying to use BarMenu to place
elements in a file that V7 does not recognize.

When a V7 file is opened in MicroStation V8, the user will not be alerted by way of a message box that
the file is Read-Only. However, the interface itself specifies the Read-Only mode:

e The title bar tells the user that the file is a V7 DGN and that the file is Read-Only.

e The Save option is grayed out under the File pull-down.

# ¥Y7Conversion.dga (3D - ¥7 DGM, Read-Only) - 1 tlicroStation ¥8.1

lﬁ? Edit Element Settings Tools  Ukilities  Workspace ‘Window b
T Hew... Ot [ —
= Open... I R —
3 Open URL
Close Chr
dZEZ> Cirl5

e The lower right hand corner of the Status Bar designates a Read-Only mode.

1

Project Setting

Within SHA, Workspace has been configured to allow the Project option to be used for Division specific
configuration if desired (internal).
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YWorkzpace

User |MD5H.-‘5-."-"E m =
”l:l Praoject

Iﬂterface_ o Project
Bridge
HISD
TEDD

Mew...

Consultants may utilize the Project option however they see fit.

Interface Setting

Within SHA, the interface setting has been configured to control the custom menus and toolboxes that
are loaded for a specific user.

The initial time a user uses MicroStation V8 and the MDSHA V8 01 workspace, the interface setting will
be set to default. Upon entering a MicroStation file, the workspace will capture the user’s NT login name
and build an interface for the user so that it will be available for all future sessions of MicroStation.

Note:

The interfaces and preferences have been organized by offices. If a user should have to delete
his/her interface or preference file, the file would be located in
S:\CADD\Workspace\Users\Prefs\ <office>\<username>.

YWorkzpace

User: [MOSHAWS D ;I
F'r|:||ect |N|:| Project

default _
GBocharow
J5hiu
LBanks
kW aniadert
STituz
Mew...

Consultants may utilize the interface option however they see fit.

Saving a V7 file to V8

Because of the configuration of the MDSHA workspaces, the user must manually convert a single file
from V7 to V8 by performing a Save As operation.
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E?Ttunversiun.dgn (3D - ¥7 DGN, Read-Only) - MicroS

J File Edit Element Settings Tools

Utilities

Chrl+M
Chrl4+D

Chrl+t
(o

Workspace

Zompress Design

[, Y S

Important: The decision to convert V7 files to V8 should be made by the Project Manager. No files
should be converted without permission of the Project Manager. V7 files DO NOT have
to be converted in order to be referenced or viewed in V8.

Multiple files may be converted by utilizing the Batch Converter tool in MicroStation V8. Additional
information on converting V7 files to V8 may be found in the CAD Manual.

Workspace Versioning

As changes are made to the workspace, a new version of the workspace will be distributed. It is
important, especially for technical support issues or when working with consultants, that the user know

exactly which workspace version he/she is currently using.

To check the workspace version being used:

1. From the MicroStation pull down menu, select Workspace>About Workspace.

pstation ¥8.1 Scale:
;| Workspace  Window  Hel

Preferences. ..

Configuration, ..

Cuskomize

Function kews...
Button Assignments. ..

Digikizing

About Workspace

2. The invoked dialog will display the workspace version in the title bar of the dialog.

& MDSHA ¥8.00 Workspace [M))SHA ¥8

=101 x|

Izer Configuration: . ACADDYW orkzpaceuzerssMDSHA WE 01 uct
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Note: SHA workspace versions will have the format V#.##. Also note that the workspace version
number may differ from the workspace name.

Each of the MDSHA workspaces is associated to a specific MicroStation workmode. The About
Wprkspace dialog will give you information about the Workmode associated with the workspace you are
using.
Hands On Exercise: Using the V7 Workspace
In this exercise, we will open a V7 file from an old project and explore the MicroStation interface.

1. Launch MicroStation from the desktop icon.

2. At the MicroStation Manager dialog, select the MDSHA V7 workspace.

= Workzpace

User [MDSHAWT
Project: Mo Project

Ll Lef 4]

Interface: |default

3. Open the file C:\Training\Chapter2\dsO01md5chl.dgn.

4. On the Attributes toolbar, click the arrow next to the level number field.

43

&0
Fd

v o [
v o O
49 v o O
v o
F N |

Notice that the levels are numbered instead of named. The MDSHA V7 workspace has been configured to
show the user just the level number. The workspace is also using MicroStation’s V7 workmode. Let's
explore what limitations we have when using this workspace.

5. From the MicroStation pull down menu, select Workspace>About Workspace.

btation ¥8.1 Scale:
Warkspace MDSha-IDS

I Preferences. .. '
Configuration, ..
Cuskomize

Function Keys...
Button Assignments. ..
Digitizirg

about Workspace
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Notice the invoked dialog not only tells you what workspace, project, interface and preference file you
are using, but also information about the V7 workmode.

About Workmode

"rou are in WY wWorkmode, MicroStation dizables certain
functionality in thiz work. mode bo prevent creation of data that
cannot be saved to %7 design files. The functionality dizabled
inchides:

- Referencing %8 and DWwG files

- Creating new levels

- Creating new viewgroups:

- Creating new models:

- Referencing 30 files ta 2D files

- Mamed Groups:

The full functionality of MicroStation %8 iz available when using %8
format dezign files.

Any MicroStation V8 functionality that is not recognized by MicroStation J is disabled. However, the user
does have the ability to add new elements to the design file in V7 workmode.

6. Close the About Workspace dialog.

7. Use the Place Smartline tool to add an element on level 20. You may use any color,
weight and style you wish.

8. Exit the MicroStation file.

Hands On Exercise: Opening a V7 file using the V8 Workspace

In this exercise, we are going to open the MicroStation file from the previous exercise. However, instead
of using the MDSHA V7 workspace, we are going to use the MDSHA V8 01 workspace.

1. Launch MicroStation from the desktop icon.

2. At the MicroStation Manager dialog, select the MDSHA V8 01 workspace.

= Workzpace

User [MDSHAYE
Project: Mo Project

Ll Lef 4]

|nterface: |BHenry1

Note: Have you used the new workspace yet? If your login name is listed in the interface field, you

have. If today is the first time you have used the V8 workspace, your interface was created when
we opened V8 in Chapter 1.

3. Open the file C:\Training\Chapter2\dsO01md5chl.dgn.
A warning message should appear:
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File is Read;/Only X|

You have opened a %7 file in a W8 workspace! Please close the File
and select a different User from your Workspace opkions!

4. Press OK.

In the last exercise we opened a V7 file with the V7 workspace. That workspace allowed us to add new
elements to the design file.

Take note that the new element you placed on level 20 in the last exercise is in fact in the file.
5. Select the Place Smartline tool.

Notice that both the Tool Settings window and the Message Center alert us (in case we forget) that we
cannot add any elements to the file because it is read only.

i

| €3 Tool not allowed. File iz Fead-Only

The only way to add elements to this file would be to use the V7 workspace (the preferred method) or to
convert the file to the V8 file format.

6. Close the file.

File Naming Convention

Establishing a standard file naming convention is necessary to easily and quickly identify a file. In
addition, following a uniform file naming convention allows Windows Explorer and ProjectWise to group
similar files together in the project directory interface.

The IDS CAD Committee has established a standard file naming convention for SHA projects. This naming
system incorporates a file's group, discipline, type, sequence and project information.

The extension for all design files should always be the default DGN.

Note: Not all files will be created from scratch. In addition to files accumulated, shared and managed
through ProjectWise, files may be received from other sources (internal or external). Unless
otherwise instructed, DO NOT change any file hames of existing files.

New DGN files using the new CAD standards would have the following format:
fDD-****_project.dgn where:
f = File Group
DD = File Discipline
***x* = Sequence descriptors — these designations vary depending on File Group

project = Division Specific Information (Route #, TIMS #, Bridge #, etc.)
File Group (f)

File group defines the general purpose a file will serve within the workflow of a project. The file group is
identified by a single-letter abbreviation as the first character of the filename.
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The five file groups designated in the CAD Standards are as follows:

e Print Files (p) - Print files are any files that are printed directly as a “final product”. This
includes Contract documents, plan sheets, profile sheets, cross section files, schedules, brochures
and wall displays.

e Model Files (m) — Models files contain any coordinately correct information that spans the
project. These models may represent existing or proposed engineering information in the field.
These files will be referenced into the final print file (explained below).

o Existing Model Files contain existing features for the project.
o Proposed Model Files contain proposed design features for the project.

e Detail Files (d) — Detail files contain any detail plates in the book of standards, bridge design
details and base linen or border files. This file will then be referenced into the final print file.

e Miscellaneous Files (x) — Miscellaneous files are primarily reserved for the Base Linen (Border)
file, this file group shall be used for any files that do not fit neatly into any of the above
categories.

Note: Model, Detail, and Miscellaneous files are typically referenced in to Print files.

e Support Files (s) — Work files are nonstandard files that are needed in the design process but
not referenced into print files. Work files may be needed for applications such as InRoads and
GEOPAK but may also be “scratch” files used for miscellaneous sketches and calculations.

The majority of the files used on a project will be model and print files.

Note: In order to identify parts of the file name easier, it may be advisable to specify the file group as a
lower case character.

File Discipline (DD)

File discipline defines the discipline of the information contained in the file, survey, highway design,
drainage design, etc. The file discipline is identified by a two-letter abbreviation designated after the file
group.

A complete list of file discipline designations for each file group may be found in Appendix G of the CAD
Manual, however a few examples would be:

e BR - Bridge/Structure e DD - Drainage Design
e HD — Horizontal Highway Design ¢ RW —Right of Way
e SN - Signing e TO - Topography

Note: File disciplines in the V8 version of the CAD Standards have been updated. While many
disciplines have remained the same, there are some that have been changed or added.

On larger projects, all design files should be assigned exactly one file discipline; only information from
that discipline will be stored in the file. Additionally, every discipline should have 1 model file.

On smaller projects, information from multiple disciplines may be stored in a single file.

Only standard file disciplines should be referenced into plotted sheets. Referencing files with nonstandard
names into sheets is unacceptable.
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Note: Within the 1995 version of the SHA CAD Standards, File Discipline was referred to as Category.
To avoid confusion with items related to “Category Code”, the term category was intentionally
phased out.

Sequence (***x)
The sequence designation is defined differently depending on the File Group of the drawing.

Note: For drawings other than contract documents (i.e. planning, displays, environmental documents),
you may use the type designation in whatever way you see fit.

For Print files:

The sequence would follow a format of TZZZ where:
T = Sheet Type
ZZZ = Sequence Number

A complete list of drawing type designations for print files may be found in Appendix G of the CAD
Manual, however a few examples would be:

e T -—Title Sheet
e P —Plan view
e D — Detail Sheets
e S —Schedules
ex: pHD-P012_md43.dgn = Highway Plan Sheet #12

Important: The drawing number represents the number in the discipline series NOT the total sheet
count.

For Detail files:
The sequence would follow a format of SSZZ where:
SS = Sheet Type
ZZZ = Sequence Number
ex: dES-0204_md43.dgn = E&S Detail, referenced to sheet pES-D002.dgn, detail #4
For Model files, the sequence designation may be used in one of 3 ways:

1. For files that can be either existing or proposed (i.e. Right of Way discipline files or drainage
area discipline files), use a designation of E for existing and P for proposed.

2. For topography files, designate the type of data collected:
o S —Surveyed topo
o A — Aerial topo
o F - Field located
o D - Digitized
o € - Composite (combined from different sources)

3. The sequence would follow a format of AAZZ where:
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AA = Design Alternate
ZZ = Section Number
ex: mHD-0301_md43-ramp.dgn = Highway Model, Alt. #3, ramp
ex: mHD-0000_md43.dgn = Highway Model, Final Alternate, entire job

Note: 000 is ALWAYS the current version that will be referenced into print files. When a new version is
developed, name it 000 and give the current 000 the next highest available number.

For Work files the sequence designation may be used in any manner that helps catalogue the file in a
sensible manner.

Project
Project allows the user to designate a specific office standard. Options may be used in the following way:

OHD - route number
OBD — bridge number
OOTS — TIMS number
PSD — plat number

Note: The 1995 CAD Standards followed the “8.3” PC-DOS and MS-DOS file naming convention to limit
the file names to eight characters. Although there is no longer any need to limit the number of
characters to eight, the file naming convention was designed so that the first eight characters are
unique to a file within a project.

File Naming Wizard

The SHA CAD Standards include a File Naming Wizard utility. This utility will not only assist the user in
naming newly created files correctly, but also in creating multiple DGN files with a few clicks of the
mouse.

The File Naming Wizard is housed under the IDS Toolbox pull down on the MDSHA IDS Main Menu.

MDSE =
Menus  Scale |IDS Taolbax

File Maming Wizard
DR Toals k

TEMAM Anee

Once invoked, the File Naming Wizard contains two tabs of options; File Setup and Build File Name.
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File Naming Wizard x| File Naming Wizard x|
File Setup | Build File Mame | File Setup  Build File Name |
Save file(s) in directory: File: List:

#HEAO00_*, dgn

I C:ATraining), E

[~ Override Defaulk Seed File:

. I 1 - - . | ] ﬂ
FILE MAMING COMYENTION GLOSSARY & Slhoeis! ZI SleElEng SEEEES £ -

™ Open first sheek upon creation

- Group:
Describes the general purpnsgi[that the individual files serve
as part of the larger CAD produckion workflow,

- Discipline: Eroup: | j
Twpe of information appearing within a design file in kerms N
of whether it is highway design, survey, etc, Discipline: j

- sheet Type: sheet Type: I j
Walid sheet bypes for File according to selected group, I

Projeck I0:
- Seguence:
Differentiates between multiple files of same type (this is
skarting # if generating mulkiple files), [~ Select By Description
- Project ID: Descrption; I j

Division-specific information for the overall project, such as
route #, project or structure #.

Cancel | Accept | *Hover mouse over labels For help Cancel | Accept |

Hovering the mouse over the labels in the tabs will provide a description of the option.
File Setup tab:

e Save file(s) in directory: This will allow the user to specify the folder that the new file(s) will be
saved in. A browse button is provided.

*Hower mouse over labels For help

e Override Default Seed File: When toggled On This toggle will allow the user to specify a file other
than the default seed file. A browse button is provided.

e File Naming Convention Glossary: This area provides a description of each component of a
MDSHA CAD file.

Build File Name tab:

e File List: This interactive field will update as the other fields in the Build File Name tab are filled
out.

e # Sheets: This allows the user to specify how many new files are to be created.

e Starting Sequence #: This allows the user to specify the sequence number of a single new file, or
the starting sequence number of multiple files.

e Open first sheet upon creation: When toggled ON, the single new file or the lowest sequenced
multiple new file will open in the user’s current MicroStation session. When toggled OFF, the new
file(s) will be created, but the currently open MicroStation design file will remain open in the
MicroStation session.

e Group: Allows the user to assign one of the standard five file purposes to the new file(s).
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araup: | J{I

o - Detai .
Discipline: o Model
p - Prink
Sheet Tvpe: | . Support
% - Miscellaneous

e Discipline: Allows the user to specify the type of file being created.

Grgup: I rin - Madel

=
Discipline: | J}%
s

B - Bridae (Plan Design
Shest Type: BP - Bridae Prafile
; DD - Drainage (Plan) Design
Project I D - Drainage Area
DP - Drainage Profile
EF - Environmental Features
EI - Environmental Impacts
I Select By ES - Erosion & Sediment Control hal

e Sheet Type: Allows the user to select a specific sheet type according to the selected file group.

Group; I m - Model j
Disciplinie: | LT - Lighting j
Sheet Type: | _v[:%
Projeck I E : Eﬁ;ﬂ;d

e Project ID: Allows the user to specify Division specific information (Route humber, TIMS number,
Bridge number, Plat number, etc.)

Sheet |ype: | F - Froposed d|

Project ID: | 9999|

Important: A Project ID specification must be supplied when using the File Naming Wizard.

e Select By Description: Allows the user to name the file by a description of the file instead of
individually selecting the components of the file name.
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Project ID: 9999

I Select By Description

Descripkion: ighting Model, Proj

¢ Lighting Maodel, Propose
Lighting Plan Sheet =
Lighting Schedule Sheet
*Hover mousd Maintenance of Traffic (MOT) Model _|t
Maintenance af Traffic (MOT) Plan Shest

Metes & Bounds Model

Masaic Model

Moise Abatement Plan Sheet i

Note: When using this method, a Project ID must still be supplied.

Once all required fields are filled in, the Accept button in the lower right hand corner becomes available.

Hands On Exercise: File Naming Wizard
In this exercise, we will use the file naming wizard to build new MicroStation design files that follow the
V8 CAD Standards file naming convention.

Creating a new file by components

First, we will create a new file by specifying each component of the file naming convention to create and
open a new design file.

7. Open the file C:\Training\Chapter2\mTO-C000_training.dgn using the MDSHA V8 01
workspace.

8. Select the File Naming Wizard from the MDSha-IDS pull down menu.

- MicroStation ¥8.1 Scale: 1°
Wiorkspace |mD5ha-IDS Window H

SHA Barmenu

Display Current Scale |
Apply Drawing Scale

Eile Maring Wizard
DR Tools k

Note: The File Naming Wizard may also be accessed from the SHA Barmenu>IDS Toolbox.

9. On the File Setup tab, check the folder location to ensure that it is set to
C:\Training\Chapter2\.
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File Naming Wizard x|

File Setup | Buid File Name |
Save File(s) in directory:

I A TrainingyChapker2),

We are not going to Override the Default Seed File at this point; we will look at this setting later.
10. Select the Build File Name tab.

Notice the file hame component field descriptions are shown in red. Once we begin building the file
name, these will change from red to black. Also notice the Accept button is currently grayed out. Once
all the required information has been supplied, this button will become available.

In the next step, select a file to build based on your workflow.

11. Fill in the Build File Name tab using the following settings based on your area of expertise:

Area Group Discipline Sheet Type | Project ID
Bridge m - Model BD — Bridge (Plan) Design N/A 12345
Plats m - Model RW - Right-of-Way E — Existing 67890
Surveys m - Model TO - Topography S — Survey md43
Traffic m - Model SN - Signing E - Existing 34567
Highway Design m - Model | MT — Maintenance of Traffic (MOT) N/A md43
Landscape m - Model LD — Landscape (Plan) Design N/A md43
Planning m - Model HD — Highway (Plan) Design N/A md43
Highway Hydraulics | m - Model DA — Drainage Area E - Existing md43

We only want to create one new file at this point and we want to automatically open this file once it is
created.

12. Ensure that the Number of Sheets is set to 1 and the Open first sheet upon creation option
is toggled ON.

13. Check that the Starting Sequence number is set to 00.

14. Press the Accept button to create and open the file.
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Creating a new file by description

Now we will create a new file by specifying the description of the file and overriding the default seed file.
The new file we create will be a base linen sheet using the standard base linen sheet seed file.

1. Launch the File Naming Wizard.

2. Check the File Setup tab to ensure the new file will be placed in the C:\Training\Chapter2\
folder.

Toggle ON the Override Default Seed File option.

4. Browse S:\CADD\Workspace\Standards\MDSHA V8 01\dgn\Borders and select the file
xBL-22x34_Border.dgn

5. On the Build File Name tab, toggle ON the Select By Description option.
6. From the pull down list next to Description, select Base Linen Sheet.

Notice that when using this method, the Project ID field is still red, we need to fill in that field!
7. In the ProjectlID field, type training.

Now notice that the File List label is red and the file name is highlighted in yellow. This means there is
already a file with this name in the folder specified under the File Setup tab. The Accept button is also
still grayed out.

Since we already have a base linen file, we don't have to create one.

8. Press the Cancel button to exit the wizard.

Projects Managed through ProjectWise

SHA has recently adopted and begun utilizing Bentley’s ProjectWise technology. ProjectWise will allow
SHA to promote a centralized and managed storage area for all project documents. ProjectWise maintains
a secure, central repository of documents through its check-out and check-in functionality and may be
used internally or by consultants.

« 7 ProjectWise Web Explorer =10l x|

Datasource Folder Document  Yiew  Tools  Help

s ;I Mame Description File Updated Status |
e

Projects

AABDT US ¢ 2 South Interchange Improvements

2 AT376, ICC Carridors

1 CEYS2, MD 7 aver Mill Creek

T cLat E, MD 30 Hampstead Bypass
FREGE, I-70 Projects

o
TN HA186, MD 924 Main Street, Bel Air

Ty Mo 85

T MOE51, 1-270 ot Watkins il Road Extended
T MO357, MD 117

A mMos32, MD1 24

A MOET1, MD 117

T pe28s, US301 MD1 97

I PGE19, MD 202 Largo Town Center

T sP042, US 50 Feasibilty Studies

+T Projectiize Training
T standards
Dlitemp —

—M Search I

=

Although it will take some time for all SHA projects to be managed within ProjectWise, it should be
considered the preferred method for file control management.
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An SHA project template has been developed for project storage within ProjectWise.

E—% Project Template

=y cap

— Y District 1

— Y District 2

— District 3

— Y District 4

— Y District 5

— Y District &

— Y District 7

—Y Drainage

—a Environmental Features
—a Eroszion and Zediment Cantrol
—TY Landscape

—TY Mairtenance of Traffic
—TY Planning Studies

—TY Project Standards and Misc.
—TN Right-of- ey

I?El—a Roadway Desigh
—TY Structures

—TY Survey

—TY Traffic

— Utilties Existing

—TY | tilties Propased

o 'ﬁ Project Documents
o Reports
[I'ﬂ—a Projects

For more detailed information on ProjectWise, please refer to the ProjectWise manual.

Important: The use of the CAD Standards and ProjectWise is not a replacement for communication
between project team members.

Using MicroStation with ProjectWise and the CAD Standards

Once ProjectWise has been installed, there is integrated ProjectWise functionality within MicroStation V8.

Workspace Profile

A workspace profile is a ProjectWise convention that allows the location of a workspace to be defined and
assigned to a ProjectWise folder. When design file from the ProjectWise folder is opened, MicroStation
opens the associated workspace.
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¥.. ProjectWise Administrator ¥8.1 o ]
J@T Console  Window  Help |J 0= K | | _|5’|i|‘
“ fction  Wiew  Favarites “ fa o= | | c'if:. | X. | @ ‘
Tree I Favorites I Marme | Descripkion | ‘Workspace Root | 4]
EOO Datasaurces ;I Sample warkspace Sample - WOT FOR PRODU, .. CriProgram FilesiBentleyiWorkspacel, e
E@ SHAEDMSO1 e ETEESHA WS 00 V& CAD Standards S CADDYWarkspace!, 5
% wiorkspace Profiles %SHF\ Y5 RC1 Yg Standards - Release Ca...  ${_USTH_BENTLE¥ROOT MWaorkspacel U
3.& Messaging services

i - spplications -

4 | » 4| | |

For more detailed information on workspace profiles, see the Using ProjectWise at SHA training
manual.

Title Block Integration

Title block integration allows drawing information within a SHA design file title block to be generated from
ProjectWise document attributes.

The SHA V8 CAD Standards include tools to insert and update title block information using this
ProjectWise functionality.

Projects Stored on a CAD Server

Some projects may need to store files directly onto a CAD server.

Within SHA, the path of the CAD server is S:\CADD\... and is organized by division and district.
When organizing projects on a server, keep the following guidelines in mind:

e Keep all design files belonging to one project together in the proper folder. They can be
referenced easily if they are together. They may become disconnected reference files if they are
not kept in the same folder. Do not modify files in any other way.

e Update files daily to ensure the most current versions of all design files. Check the file folder on
the server to see if any newer versions exist. Also, keep updated versions of your files on the
server so that others can update your files as their reference files.

File Ownership

ProjectWise functionality will control user access to MicroStation files throughout the life cycle of a
project. Additionally, the SHA Network is set up to control file access of projects stored on the SHA
network.

However, users should recognize files that they are not the owners of, and should not edit them.

For example, the topo files are the “owned” by the Survey Division. A designer outside the Survey
Division, or a consultant, should not be modifying that file. If the file must be modified for your use, it
should be renamed to reflect that.

Seed Files

Seed files are templates for new design files. Default MicroStation delivered seed files may not contain
the settings required for SHA. Therefore, to ensure consistent design file setup, SHA specific seed files
have been created. These SHA seed files contain appropriate SHA-specific working units as well as other
settings.
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A complete list of SHA specific seed files may be found in the CAD Manual.

Level Naming

With the release of MicroStation V8, the limitation of 63 levels per file has been eliminated. A file may
now contain an unlimited number of levels, and those levels are named.

The IDS Team has developed a level naming convention based on the National CAD Standards
guidelines.

A complete list of SHA standard level names may be found in the CAD Manual.

SHA Standard level names for specific file types are stored within Level Library files. To better control the
use of the correct level library for a particular drawing type, Barmenu (the CAD Standards symbology
engine) automatically attaches and unattaches level libraries as the user selects elements to be placed.

The benefit to using this method is that a level is only added to a drawing when an element that uses
that particular level is placed in the file. This eliminates a lengthy list of levels for the user to wade
through in a drawing.

Note: Although MicroStation V8 allows the ability to place elements with ByLevel symbology, SHA has
decided not to adopt ByLevel capability at this time. This decision was made to try and reduce
the number of levels used. For example, some IDS features share a level name but may have a
different color or linestyle. If ByLevel had been used, each of these features would have required
its own level.

BarMenu will create the majority of the levels you will need during the drawing process. The IDS Team
does acknowledge that additional levels may be needed. Some additions have been accounted for in the
level files (xx-USER or xx-USER-TEXT, for example) and additional levels may be created by the user.

Please attempt to follow the level naming convention when creating new levels.

Level Display

Because of the change in Levels in MicroStation V8, a drastic change has been made to the Level
Display dialog.

The Level Display dialog may be accessed from the MicroStation pull down menu by selecting
Settings>Level>Display or by selecting the Level Display icon from the Primary Tool Bar.

BEEYcPE e

When invoked, the Level Display dialog is displayed as follows:
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B
BIB|3[4ls]s]7]sl _viewDisply |

\@ TEE_E E}-ﬂ [none] = Lewels "I

Mumber | File # Logical ~

MHD . rHD-0000_E...
BLIM-DATA, 529 MHD . mHD-0000_t...
BLIM 500 MHD . mHD-0000 L.
BLDG-TE= y MHD. mHD-0000 ...
BLDG-REMY MHD.mHD-0

i MHD.rHD-0

| MHD . mHD-000
BLDG-FILL MHD.mHD-0000_t...
BLOG-DIRS R 25 MHD.mHD-0000_t...
xx-waxl mHD-0000_trai. .
xx-USER mHD-0000_trai...
TT-HREKG mHD-0000_trai...
TR-BROAD. .. mHD-0000_tra... Maste
TR-CURB

mHD-0000_trai... Maste]=
4 | »

Level Display controls level display in individual or all views, and levels can be manipulated in selected
groups or with Level Filters.

Mame

LDG-LABL

Notice the colors of the items in the Level Display dialog:

Highlight Color Indication Method to Set
Green Active Level Double click to set as Active
Level
Black Level Display On Single click to turn on level
Gray Level Display Off Single click to turn off level
Dimmed Gray Global Display Off Single click with Use Global

active

Additionally, the column in the Level Display dialog may be customized. Right-clicking on the column

header allows the user to define the columns to be shown.

SHA_V8_0003
6/5/2004
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MHame - IT [arme

................................................................ IT Murmnber
BRDG-ABUT

BRDG-ELEV Description
CTRL |v Fie

Default Logical

Calar

Style

Weight

Lock

| Plot

|v Used
Elerments
Library

Shioee Al
List...

Columns can also be sorted by clicking on the desired column header.
Levels in the Level Display dialog that are shown in Bold are used levels.
Other features of the Level Display dialog are:

View toggles and the Mode menu

Level Display |

bizlzl4s]e|7]s! _viewDispy |
'\@ = E}“ [ane) ~ Levels |

Sets the view(s) within the model on which the levels are being displayed, if the View Display mode is
selected.

Right-clicking on any view button opens a pop-up menu with the following items:
e Apply View to All Views — applies level X display settings to all views.
e Select View Only — targets view X for level display settings adjustment.

e Select All Views — targets all views for level display settings adjustment.

Level Display |

HL Apply View 1 ko &l Yiews fpla -

h@ Select Yiew 1 Cnly |z ™

Select All Views
| M arime= LCLE I ]|m) L= LDEiEEI' ‘I
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Change Level

N

Opens the Change Level tool, which is used to toggle the display or locked status of a level.
Target Tree

x|
EEEEEEE Yiew Digplay "l"l

\@ ITE:TE %i[nune] *  Level: "l

S8 ¥a T 0-0002  dan

] tol3m4 2 dgn
] told4md 3. dgn
] tol5m4 3. dgn
] tolEmd 3. dgn

] to12md 2 dgn Ll

Used to select the target model for level display settings changes. This tree control enables selection of
the active model, another model in the open DGN file, or an attached reference in the open file or
another file, as the target.

Show Levels or Filters

b Levels
g Filters

Lists the Levels (or filters if Mode is set to Filters) in the target model.

Right-clicking the list box brings up a pop-up menu with the following options:

Menu Item Description

All On Turns on all levels in the file (and attached references if they are included in the
Target field).

All Off Turns on all levels in the file (and attached references if they are included in the
Target field).

Invert Selection Selects all unselected and deselects all selected levels listed in the dialog box.

Off by Element Launches the Change Level tool in Display Off mode.

All Except Element Launches the Change Level tool in Display Only mode.

Save Filter If the Mode is Levels and Untitled, All Levels or a filter is select from the Filter
List, the filter row appears allowing you to create an on-the-fly filter. Clicking
Save Filter opens the Save Filter dialog box for saving and naming the filter.

Level Manager Opens the Level Manager dialog box.

Properties Opens the Level Display Properties dialog box.
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Active Level Filter
§]>° [hone] =

If the mode option menu is set to Levels, sets the Filter — named or defined on-the-fly— applied to
level display.

Hands on Exercise: Level Display
In this exercise we will explore the Level Display dialog box.
1. Open the file C:\Training\Chapter2\mTO-C000_training.dgn.

2. Select the Level Display icon from the Primary Tool Bar.

BEEYcPE e

The Level Display dialog invokes.

The Level information we would like to show in the columns are; Name, Description, File and Used
Levels.

3. Right-click on the Level Display column header to display the column list.

2o |
’7 Murmber
Description
v Fie
Logical
Color
Style
Wigight
Lock
Plat
v Used
Elernents
Litor ary

Shiowe &l
List...

4. Uncheck the Number option.
5. Right-click on the Level Display column header again.
6. Check the Description option.

A Cool Tool: If you are changing multiple columns, selecting the List... option will bring up a separate
dialog to allow the user to change multiple columns at a time.

Currently, the level list is sorted alphabetically. However, we would like to sort the levels so that we see
all Used levels at the top of the list.
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7. Click the Used column header.

x
EEEEEEE Yiew Dizplay 'l
\@ E-— 0 2 [hone] *  Levels vI

MHame # Murmber File |Jzed -

Explore the list to confirm that all Used levels are listed at the top of the list.

Now we want to turn off the level that contains the Roadway Edges. We know that the name of that
particular level is ROAD-EDGE.

8. In the level list, click the level ROAD-EDGE.

HEAS STRC Utlll A Eas Emund structures mT0-0002_ md43-
ROAD-EDGE PHoad: Edge. Bottom of Curbh mTO-0002_md43.
SITE- HISE Site: Miscellaneous mT0-0002_md43.

Note: There is no longer an Apply button to apply the new settings to the view. The level is turned
on/off immediately upon its selection.

Next, we want to turn off the survey point humbers. However, we are not yet familiar with the standard
level names and are unsure of which level those elements are on.

We will use the Off By Element option to turn these elements off.
9. Window in to the area inside the existing loop close enough to see the survey point numbers.
10. In the Level Display dialog, place the mouse cursor inside the level list box and right-click.

A menu appears.

All O
Al Off
Invert Selection

Off By Element
All Except Elerment

Save Flter,..

Level Manager

Properties

11. Select the Off By Element option.

12. Graphically select one of the survey point numbers.

SHA_V8_0003 223 SHA
6/5/2004 lﬁg
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@._3?52
| Test Mode, Test [SURW-LABL]
Fa

Notice in the level list that the survey point numbers are on the level SURV-LABL.
Before we close the file we will turn off all the levels in the file.
13. Use the right-click option to turn off all levels.

Next, we are going to manipulate levels in multiple views since we no longer have the Apply and All
buttons to manipulate levels.

14. Using the View Groups dialog, open View 2.

JIEJ Defaul j‘ [ ‘E EEHE

All levels are turned on in View 2.

15. In the Level Display dialog, click View 2 in the View Index.

Level Display

Wiew Dizplay "’l

v Levelz ™ I

16. Right-click on View 2 in the View Index and click Apply View 2 to All Views.
Notice that all levels in View 1 appear again.

17. Right-click on View 2 once again in the View Index and click Select View 2 Only.

18. Turn off a few levels and see the result.

19. Close View 2 by using the View Groups dialog.

DGN Library

As mentioned in the V8 Features section, DGN Library files (DGNLIB) can be used to maintain and deliver
CAD Standards.

SHA has decided at this time to maintain only level filters via DGNLIB. One reason for not using DGNLIB
files fully is that any standard component in a DGNLIB is locked and cannot be edited. To allow some
refinement to take place, all other standard components are delivered in some other way.

Note: Future updates to the SHA standard may likely expand the use of DGN Libraries.

Level Manager

Level Manager is used to control Levels and level symbology for the Active Design file and attached
Reference Files. The Level Manager Dialog Box <can be accessed either through
Settings>Levels>Manager or by clicking the Level Manager icon on the Primary Tool Box.

BsEaE 05 e
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Below are the default capabilities of the Level Manager, along with SHA CAD Standard usage:

Create, Rename and Delete Levels — Because SHA is implementing Level Libraries, only
levels created by the user can be renamed or deleted.

Set ByLevel Symbology — SHA is not currently implementing ByLevel Symbology.

Set Level Override Symbology — SHA does not currently have pre-defined override symbology
however it may be used if desired.

Create Level Libraries — Level Libraries are loaded automatically through the SHA Workspace
configuration and through Bar Menu. Users will have no reason to create Level Libraries.

Create Filters — Standard Level Filters have been created in the DGN Library. However,
additional Level Filters can be created if necessary.

When the Level Manager is invoked the following dialog displays:

SE

Lewels

Filter  Edit

@ 4 | @ |5ymbnlu:ugy: ByLevel "|| E}D [hone]

[*( mDP-0000_md43. dgn Logical | Calar -
3 Al Level e L L 4
# AlLeves AXISTITL 27 .. \Awis, Title ... Master 1D 0 0
o~ Filters GRID-MAJR 28  ._AGrdLines. ... Master (10 0 0
GRMD_E b 5...\ Existing Grounc Master [0 0 0
GRHD_P 5 ...\ Proposed Grount Master [0 0 0
HGL_-025Y 15 ...\ Hypdraulic Gr... Master [0 1] 1]
HOTE 30 ...\ Notes, Misc... Master []0 1] 1]
STRM-DTCH 13 D...\ Ditch, Channel Master [0 1] 1]
STRM-FIPE 12 Drainage: Pipes Master (10 0 |1
.| | ’
| sctive Level: Default |61 of 61 displaped

Within the scope of the SHA CAD Standards, typically Level Manager will only have to be accessed to
create additional Level Filters.

Level Filters

Level filters serve two purposes: (1) to limit the number of levels that appear in a level list, and (2) to
turn groups of levels on and off when needed. The latter application will be especially critical for helping
control level display of attached reference files.

Level Filters are maintained in a single DGNLIB file that is always referenced by the SHA Workspace so
that all level filters are available at all times.

Level Filters may be accessed by selecting the Level Filter icon either:
On Attributes toolbox:

p——

=] I
3o &l v | [Yetau

Ld
]
m

nv“

On the Level Display dialog:

6/5/2004
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Level Display x|

H ame |
All. Linework Only

All. Text Only

All. Uzed Only
Wegetation. Linewark Only
Yegetation. Text Orly

Users are able to create their own level filters if desired through Level Manager. The user’s level filters
will be maintained in the design file.

Hands on Exercise: Level Filters

Using Existing Filters
In the first portion of the exercise, we will explore using the default Level Filters set up in the SHA CAD
Standards.

1. Continue in the file C:\Training\Chapter2\mTO-C000_training.dgn.
Confirm that all levels are turned OFF in View 1.
2. Select the Level Display icon from the Primary Tool Bar.

BaEScPe

We will first look at using level filters to control the number of levels that are displayed in the level list.

3. Inthe Show Levels or Filters option box, make sure that the option is set to Levels.

F Levels
g Filters

4. In the List Filter option box, select any filter.

Notice the change in the level names listed in the level list box. Also notice that although the level list
has changed, the display of levels remains the same. At this point, we are only controlling what level
names are being displayed, not the actual display of the elements within a level.

5. Select the Survey Points filter.

6. Turn ON the SURV-DNC level in the list box.

Now we have used a filter to limit the level names displayed in the list box and then used level toggling
to control the element display.

7. Select the All filter and turn all the levels in the file OFF.
This time we will look at a quick way to control the display of our elements by using Filters.

8. In the Show Levels or Filters option box, set the option to Filters.
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Levelz
* Filters
Notice the change in the list box. Instead of a list of the levels in our file, a list of the filters is displayed.

Level Display x|

EHEEEHE Yievs Dizplay "l
R@ TEE_E E}-ﬂ Uzedili = Filters "I
Marme | :I

All. Linework Only
All. Text Only
All. Uzed Only
Linework Only
Text Only —I
Uszed Only

Arooeszs - |

Note: Bolded filters designate elements within that particular filter.

9. Select various filters (and combinations of filters) and notice the change in the elements
that are displayed.

Creating New Filters
In this portion of the exercise, we will create new Level Filters, one “on the fly” and one that will be

saved with the design file.
1. Continuing in the file C:\Training\Chapter2\mTO-C000_training.dgn, in the
Show Levels or Filters option box, set the option to Levels.

Notice the blank fields at the very top of the Level List box.

Note: If you don't see the blank fields, set the List Filters option to Untitled.

x|
EEEEEHE Yiew Digplay "l
l‘@ TE__E %G“Used * Levels “'I

I amne D ezcription File

.

|
BARR Road: Traffic Bamiers mTI]-I]I]I]Z_md43_I

T R Tan

nOe AT oo an

These fields will allow us to create “on the fly” level filters.
2. In the blank field under the Name heading, type grad and hit ENTER on the keyboard.

Notice that there are 4 levels that passed this filter.
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|
n 2|3|4|5|E|?|E| Wiew Display v|

.‘@ IE E}““Suwe_-' Levels ¥ |

I@ T
Mame £ Mumber | File Laogical [ Uzed
grad
GRAD-BRKL 215 mT O-CO00_training.dagn Master =
mT O-CO00_training_dagn Master =

Highlighting either or both of the used levels will turn these levels ON in the design file.

Since this is an “on the fly” filter, this filter will not be saved once the file is closed. The SHA CAD
Standards allow for situations where the existing filters do not fit the information you would like to filter.

In this case, we would like to create a filter for any level that's Description begins with Walkways.

3. Open the Level Manager.

Note: Just as the Level Display dialog, all columns may be customized.

In the left hand list box, notice there is an option for Filters.
4. Highlight the Filters category in the left hand list box.

5. Right click Filters and select the New option from the pop up menu.
ngel Manager
Levels Elter Edit
j b | @ | Symboloay: || Bples
(1 mT0-0002_rd43. dgn Fil

3 Al Levels JI

- e I |

Leve! Groua | e

6. Scroll the list until you see the Filter New Filter (0).
First, we want to give our new filter a name that will make sense to us.
7. Right click the filter and select Rename from the pop up menu.
8. Type the name Walkways and hit ENTER on the keyboard.
Now that our new filter has a name, we need to define the filter.

9. In the blank field under the Description column heading, type Walkways: and hit
ENTER on the keyboard.
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Notice that the level list now displays only those levels that passed the information we supplied. Now
since we created this filter in the Level Manager, the Walkways filter will be available to us any time
this file is open.

10. Close the design file.

Cells

Cells have not undergone a significant change in the current version of the SHA Standards.
e Units have been changed to match the seed files
e Proposed traffic cells have been renamed to match Sign Book standard numbers
e Level names were assigned

When using the SHA CAD Standards, the True Scale toggle will ensure that any cell resolution issues are
resolved when placing a cell.

Important: Always make sure the True Scale option is turned ON when placing cells.

& i =
Active Cell: | TELMH

Q

Active Angle: | 0.0000° =

# Scale: | 1.000000 —l
— i
_|

Y Scale: | 1.000000
£ Seale: | 1.000000

¥ Tiue Scale

Line Styles

Line styles have undergone a big change in the current standard. Linestyles added for Planning and
existing utilities and linestyles have been renamed. However, the biggest change is scaling of the
linestyles. Any linestyle that requires a change in size depending on the drawing scale will be scaled
appropriately.

Barmenu will help the user control the drawing scale so that linestyles will be scaled correctly as well as
remove or apply a scale setting.

Scaling

Barmenu defines a “drawing scale” in a MicroStation file. This scale will affect linestyle, text and cell
sizing in a drawing.

Within Model and Print files, only one scale should be used within a single file. When a drawing scale is
selected, all scalable elements will be updated for the newly applied scale.

However, within Detail files, many times it is necessary to have several different scales within one
drawing.

Fonts and Text Sizes

SHA Standards dictate the use of MicroStation font nhumber 3 (FT=3) for all text. Do not use custom
fonts.
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On a full size plotted sheet, the following text sizes should apply:

e General text should be 1/8” high.

e Title text should be 3/16” high.

e Annotation text such as building and street names should be %" high.
Barmenu will correctly size the text depending on the drawing scale.

A list text sizes for particular drawing scales may be found in Chapter 4 of the CAD Manual.

Text Styles

In the current release of the SHA Standards, several text styles have been created. These text styles
have been added to the seed files instead of the DGNLIB so that they may be scaled along with the
drawing scale.

Important: If a user changes the drawing scale of a file that already contains text, the macro that
BarMenu uses to scale text styles will break the association of the text with the text style
used to create it. The text will however retain all of its original attributes. (The scale of
a drawing should rarely be changed midstream; the exception pertains to certain detail
drawing workflows.)

If you have already placed text into a drawing and change the drawing scale, you will receive the
following message:

warning x|
& Changing drawing scale will set all existing text to

style 'Mone’. Howewver, text attribukes will not change,
Do wou want ko proceed?

Ok, I Cancel

Dimension Styles

In the current release of the SHA Standards, five dimension styles have been created. These dimension
styles have been added to the seed files instead of the DGNLIB so that the user has the flexibility of
changing a terminator or the number of decimal places for a particular dimension.

The styles created are:
e  Architectural
e Civil
e  Structural
e Survey

e Details
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Il

Fil

t Structural E3 ﬁ d | * FE:'_E

1 Siyle:[none] Uze Active Settings

1 Architechtural for uze with Facilitiez

Structural for uze with bridges

= Ciwil for uze with highways —

i Details for uze on detailz

= Survey for uzing bearings

12;:[6”':& [T Alternate Label

Tool Settings [Fdistanceiz = ¥ Il [/oEoo kL
(T securacy: [ i
IIrut Format LEI':IE': b1l -

[T Show Secondamy Units Settngs... |
Scale Factor: |1.EIEIEIEIEIEI

Select curent settingz from narmed dimenzion style

Focus ltem D escription

Detail Model

Although SHA is not standardizing model use, it is recognized that there are some division workflows that
would benefit greatly by the use of models. For example, one possible use for multiple models would be
used for detail sheets. The example we will explore will involve a possible workflow for developing details.

A seed file named shaDetail2D.dgn has been developed should a user decide they would like to use it.

This seed file contains 10 models and also has the SHA border attached.

i
Da s x g
Dezcription

O 1in 1"=1"0" D etail Madel

O 24 34"=1"-0" Detal Model
O 12in 1/2"=1"-0" Detal Maodel
O 38in 38"=1"0" Detail Maodel
O 14in 1/4"=1"-0" Detal Madel
O 3216k F3AE"=1"0" Detail Model
O 18 1/8"=1"-0" Detal Madel
O 332in 3320=1"0" Detail Model
O 15in 1-142"=1"0" Detail Madel
O 32k 3'=1"0" D etail Madel
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Chapter 2: SHA CAD Standards Concepts

“Models” are containers within a design file to hold elements. These models can be referenced into each
other within a design file or across design files.

The model workflow may be useful for drawing bridge details since these details are typically drawn in a
MicroStation design file with the Bridge border in the file. The advantage is that all detail elements are
drawn in full scale but shown up in the border scaled appropriately. Text and dimensions will also be
scaled appropriately.

The details may be placed anywhere on the sheet and all details, no matter what the scale, appear on
the sheet to aid the user.

Let's look at an example:

Hands On Exercise — Using the SHA Detail Model

In this exercise, the standard shaDetail2D.dgn has been used to create a new file (pBR-
D000_training.dgn). Additional elements have been added to the file to assist in understanding this
concept. For example, elements may be drawn anywhere in the design file, however labels have been
placed at the locations that we are going to place the elements. This is so we can easily remember the
scale of the elements placed.

1. Open the file C:\Training\Chapter2\pBR-D000_final.dgn
This file shows what we will be working toward in this exercise.
Adding Elements
2. Open the file C:\Training\Chapter2\pBR-D000_training.dgn
Each model in the file has an associated view group which allows us to quickly switch between models.

3. Click on the View Groups menu.

Mame b el

[ 1 2inViews [&1:2in
[ 1 4inViews [E14in
1 1 8inViews [&i15in
[ 1.5 in Views 1.5in
[ Tin Wiews Tin
[ 2 4inViews 24in
[ 28 inViews 38in
[ 316 in Views 316 in
[ 232 in Views 332in
[ 2 in Wiews Fin

0 Default

Bl [HEREEEE

Delete Element » 1dentify element

The view groups list display all models that are contained in the seed file used to create our example file.

First, we are going to draw a few simple MicroStation elements. Before we draw the elements we are
going to specify the scale of our individual “details” by selecting the appropriate model.

4. Select the 1 in view group to switch to the 1”=1"-0" model within our design file.

Notice in the MicroStation Title Bar, the model as well as the design file name are displayed.

2-32
004 DS

Integrated Design System



Chapter 2: SHA CAD Standards Concepts

Z5 PBR-DOD0_training.”yn, 1in (2L - ¥8 DGN) - MicroStation ¥8.1

Qtilities Warkspace MDSha-IDS

File Edit  Element

5. Using MicroStation, draw a 3'x3’ block to represent the element we are detailing in the
area of the 1”=1'-0" label within the border.

6. Select the 1.5 in view group to switch to the 1 ¥2"=1"-0" model within our design file.

Using MicroStation, draw a 3'x3’ block to represent the element we are detailing in the
area of the 1 /2"=1"-0" label within the border.

Although the elements we drew are drawn full size within the model we drew them in, the elements show
up within the border scaled appropriately.

8. Select the 1 2 in view group to switch to the ¥2"=1"-0" model within our design file.

9. Using MicroStation, draw a 3'x3’ block to represent the element we are detailing in the
area of the 12"=1"-0" label within the border.

Important: In order for the elements to be displayed at the correct scale within the border, the user
MUST correctly set the appropriate model before placing elements.

Adding Text and Dimensions

Next we will add titles and dimensions to our details using text styles and the Scale option from the IDS
Main Menu. We are not going to use Barmenu to place these elements because many of the detailing
items for this particular workflow are not currently included in the available features from the IDS Main
Menu.

10. Continue in the 12"”"=1"-0" model.

11. Select the ¥/2"=1"-0" Architectural scale from the Scale pull-down on the IDS Main
Menu.

MDSE B

Menus | Scale  IDS Toalbox

Display Current Scale |

Civeil 2
Metric L4
Architectur al 3 =1-0"

Full Scale {1"=1") 1-1f2" = 10"
1"=1-0"
34" =1-0"

apply Drawing Scale
Ignore Drawing Scale

aet — 1"
12. From the MicroStation main toolbox, select the Place Text tool.

13. In the tool settings window, select the text style Detail Title.
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Il

Method: By Origin "l
TestStyle: [H Detal Ttle =] @
Active Anagle; |EI.EIEII:IEI° E
r Height: [0.6800 4
r width: [O.3440

14. In the text editor window, type DETAIL TITLE.
15. Place the detail title below the 2"=1"-0" detail drawn previously.

16. From the MicroStation main toolbox, select the Dimension Element tool.

A

7 R 2| o | 7 T

—_—
H:t\;l“ o =
Dirmension Element

17. In the tool settings window, toggle ON the Association option.

Important: If the Association option is unavailable, turn on the Association lock.

Axis
Grid
ik

IJ lﬂ_[ Graphic Group

18. Set the dimension style to Structural.

Since each dimension style can be associated to a text style, we want to check which one is currently
being used.

19. In the tool settings window, click the magnifying glass next to the dimension style.

I ]

4 Stiuctural Ed _C'[ﬂ
Alignment;  True "I
V¥ Aszsaciation Cirmension Styles

Ment

This will launch the Dimension settings dialog and allow us to check the Text Style.

20. In the Dimension Settings dialog set the Text Style to Detail.
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S=E

File
[ Structural =] ﬁ = x %
Onentation:  Above b

Custon Symbolz
Dimenzion Lines Justification:  Center i

Dimenzion Wwith Leader Test Frame:  Mone vI

Extension Lines Left Margir: [ 0.500000
Placement .
T erminatars LQ'.-T\.'EI Margln:\ I 0.500000
T erminator Symbols
(IET oo Gt (o)
Tolerance [T Color:
Tool Settings M weight MI
Urits 3 Detail Subtitle
IJrut Format I™ Font il Ti
. Y petail Title
" Height: % Existi
i xighing
[ width: % | ahel
[T Underline % Label [Fancy)
Focus [tem Dezscription 21 Match Line I
b1 Propozed

The zelected text style controls the presental

-1 Propozed [small]
-1 Stationing

3 Title

21. Select one of the elements in the 2"=1'-0" detail to dimension.

22. Switch to the 1 in model and repeat steps 10-20 to place the title and dimensions on
the 1"=1"-0" detail.

23. Do the same for the 1 2"=1'-0" detail.

Associated Dimensions

Because we chose to associate our dimensions when they were placed, if the element changes, the
dimension will automatically update to reflect the element change.

24. Select the 12"=1"-0" model.

25. Use the Modify Element tool to change the length of the top element in the 12"=1'-
0" detail.

26. Review the result.
27. Close the file.

Color Tables

SHA does not use the Bentley delivered color table; but a customized color table named ClorMdSha.tbl.
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Color Table

File Edit
HYE EE Tl

The SHA color table should be used on all SHA projects.
When using SHA's standard pen tables and plot drivers, the following colors will always plot as wysiwyg:
232-239: grey scale
240 - 244: SHA logo and additional colors
246 —247:  green lining
252 — 253: red lining

3D and 2D Files

MicroStation V8 eliminates the pitfalls many users faced with 2D vs. 3D files in V7. For example, grading
files are often drawn in 3D; however, horizontal design files are often drawn in 2D. The grading file
would have to be “flattened” in order to reference it into the horizontal design file. The 3D file would
have to be exported to 2D, thereby creating a duplicate grading file. Any changes in the 3D file would
have to be updated in the 2D copy.

With V8, that 3D grading file can be referenced into the 2D horizontal design file with no problem. There
is no longer the need for duplicate files in MicroStation V8.
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Chapter 3: BarMenu

Lesson Objectives

In this lesson, you will use Barmenu and the IDS toolbox to place MicroStation elements conforming to
SHA Standards. In this chapter, the topics covered include:

e SHA CAD Standards Interface
e Reloading the SHA Bar Menu

SHA CAD Standards Interface

When a design file is launched in MicroStation V8, using the SHA CAD Standards Interface, at least one
additional toolbox will be loaded above and beyond the typical MicroStation toolboxes. This is the MDSHA
IDS Main Menu.

MDSE g

Menus Scale  IDS Toaolbox

Note: It is possible that other SHA menus will load upon launch of a file. When opening a newly created
or existing file, if the MicroStation file follows the SHA Standard File Naming convention, the
appropriate drawing menu will also load.

Menus
The Menus pull-down holds all menus related to a particular drawing type.

MDSH F
Menus  Scale  IDS Toolbox
o Bridge
Drainage Drainage Area Map (mDa)
Landscape Drainage Design Model {mbC
Mapping ¥  Drainage Profile Madel {mDP)
Planning ¥ Proposed Grading Model {mGR-P)
Plaks & Surveys ¥ Erosion & Sediment Control Model {mES)
Roadway »
TrafFic r

Layout File (xLa)

Roadway Plan Set »
Traffic Plan Set ]
Documents k
Displaws r

]

Miscelaneous

When a menu is selected from the Menus pull-down, the appropriate menu will load.
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Utilities, Prop |

Eleckric  Gas&Oil Comm  ‘Waker  Sewer  Steam

Note: Behind the scenes the appropriate levels will be loaded into the Level Manager of the current
design file. A level will only be added to the design file when an element is placed that uses that
level. This will keep the number of levels in a design file at a minimum.

Each menu is broken down into categories, which contain the individual components that will be placed in
the MicroStation design file.

Planning Displays |

wall Displavs (DI)  Brochure Graphics  Enwiron. Docs (ED) R Cost Maps  Landscaping  Environ, Impacts (EIY - Future Developments (PFY - Mitigation

Border

Plat Title
Sub Title
Morth Arrow

Title Block Border
Legend r Sheet #
SHA logo Scale

Text Labels v ]

Match Line
Match Line Texk

Selecting a component will set the appropriate MicroStation symbology, launch the appropriate
MicroStation tool and set any specific tool settings.

Scale
The Scale pull-down holds tools related to setting and applying scales to a MicroStation drawing.

One of the benefits of the IDS Menu is the ability to quickly scale elements like Linestyles, Text and Cells
relative to a Drawing Scale.

MDSHA ] x|
Menus | Scale  IDS Toolbox

Display Current Scale

Civil 3
Architectural 3
Metric »

Full Scale (1"=1")

Apply Drawing Scale

Ignore Drawing Scale

Display Current Scale will display the current drawing scale in the MicroStation title bar if for any
reason the Scale is not displayed.

— N
gI'I.I'Ihd-I]I]I]1-th3.dgn (2D - V8 DGHN) - MicroStation V8.1 Scale: 1" =580"

———————
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Civil, Architectural, Metric and Full Scale allow the user to select a hew drawing scale.

Selecting a different Drawing Scale will not affect existing elements in the design file. Any elements
placed in the design file after a different scale is selected will be scaled appropriately.

Note: Typically, a single scale would be used in a single drawing. However, it is possible that for detail
models, multiple scales would be used.

Many of the text elements placed with the IDS Menu will use Text Styles to control the text settings of
that feature. Changing the Drawing Scale requires BarMenu to break the link between previously placed
text and the Text Style used to place it.

Apply Drawing Scale and Ignore Drawing Scale should only ever have to be used if elements are
placed manually (without the aid of BarMenu).

Important: Elements that use cells, custom linestyles, text or dimensioning may not scale correctly if
they are not placed with BarMenu.

IDS Toolbox
The IDS Toolbox pull-down contains additional tools to assist the user in production of SHA plans.

MDSH E
Merus  Scale | IDS Toolbox

File: Marming YWizard
DR Tools

TEDD Apps

Sign Tool

glnt Bore Log L4

InfoSnap
InRoads

Raotate YWiew By Poinks

Rotate Yiew By Elernent

Reverse Linesktyle
Shifk: Linestyle

Impart SHA Texkskyles
Import SHA Dimension Skyles

Insert Title Block Data
IIpdate Title Block. Daka

Some of the options from the IDS Toolbox menu will launch additional toolboxes; some may launch an
individual tool.

Reloading the SHA Bar Menu

Although the SHA Barmenu loads when a design file is opened, it may be necessary at times to manually
reload the MDSHA IDS Main Menu. There are two ways to reload the menu.
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Method 1 — MDSha-IDS pull down

From the MicroStation pull down menus, select SHA Barmenu from the MDSha-IDS menu.

icroStation ¥8.1 Scale: 1" =1"

Wiarkspace | MDSha-IDS  Window  Help

Display Current Scale |

P el Drawing Scale

L] I N R S N i |

Note: Notice the other tools in this menu. Although these tools may be found within the SHA Barmenu
itself, they can be quickly accessed here as well.

Method 2 — Loading the MDL Application

1. Open the MicroStation key-in window by selecting Utilities>Key-in from the MicroStation pull
down menu.

2. Key in mdl load shabarmenu and either hit the ENTER key on the keyboard or select the
Run Key-in button on the Key-in window.

Key-in #]
|mu:|| load shabarmenu j 'El l?a =
iy

A Cool Tool: If you find yourself often using the key-in to load the SHA BarMenu, you can always set
up a function key. This is done by accessing Workspace>Function Keys... from the
MicroStation pull down menu.

Hands on Exercise: Using SHA CAD Standard Menus (Plats and
Surveys)

Placing Features using BarMenu

In this section, we will practice placing model features using BarMenu. This section will be open practice
to let you start to get familiar with the menus you would typically be using.

1. Open the design file C:\Training\Chapter3\mTO-C000_exercise.dgn.

Notice that when the design file is opened, the Topographic Model menu is automatically launched. This
is because the design file follows the standard file naming convention so the appropriate menu will
launch.

2. Select various features from the Topographic Model menu.

Drawing Scale and Linestyles
In the next few sections we will practice using the scale options for the CAD Standards.
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1. Continue in C:\Training\Chapter3\mTO-C000_exercise.dgn.

2. Make sure the Drawing Scale is set to a Civil Scale of 1"=50".

Note: If you placed text into the model in the previous section of the exercise and change the drawing
scale, you will receive a message warning you about the Text Styles. Select OK.

3. On the Topographic Model menu, select the Woods Line feature from the Foliage
group.

Topographic Model (mTO)

Conkrol  Surfaces | Foliage Road  Barrier  Bridge Draina

Coniferous Tree

Deciduous Tree

Notice the MicroStation symbology is set automatically and the Place Smartline tool is launched.
4. Place a Woods Line in the file and reset.

5. Change the drawing scale to 1"=20".

MDSHA ] |
Merus | Scale  IDS Toolbox

Display Current Scale |

Mektric
architectural » 1"=30
Full Scale (1"=1") 1" =40’

6. Once again select the Woods Line feature and place another smartline.
Notice that the Woods Line scales automatically.
Drawing Scale and Symbols
Symbol features respond to the drawing scale in the same way.

7. Select the Brush Symbol feature from the Surfaces group.

Topographic Model {(mT0O)

Control | Surfaces  Foliage FRoad  Barrier  Bridge [

Weetland Boundary
Wetland Symbol
Spring Head
SwampMarsh Line
Swamp Symbol

Cultivated Field Syml:u:u| 5
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Again notice that the symbology is set as well as the Place Active Point command.
8. Place an instance of the point and then reset.
9. Change the drawing scale.

10. Place another instance of the Brush Symbol feature and reset.

Hands on Exercise: Using SHA CAD Standard Menus (General)

Placing Features using BarMenu

In this section, we will practice placing model features using BarMenu. This section will be open practice
to let you start to get familiar with the menus you would typically be using.

3. Open the design file C:\Training\Chapter3\mDA-P000_training.dgn.

4. Select various features from any of the Models menus.
At this time, only concentrate on the Models menus, we will be exploring the other options shortly.
Drawing Scale and Linestyles
In the next few sections we will practice using the scale options for the CAD Standards.

11. Continue in C:\Training\Chapter3\mDA-P000_training.dgn.

12. Make sure the Drawing Scale is set to a Civil Scale of 1”"=50’.

Note: If you placed text into the model in the previous section of the exercise and change the drawing
scale, you will receive a message warning you about the Text Styles. Select OK.

13. From the IDS Main Menu, select the Drainage Area Map menu.

MDs| gl
Merus  Scale  IDS Toolbox
o Bridge
Drainage Drainage Area Map (mba)
Landscape Drainage Design Madel (mDD)
MMapping ¥ Drainage Profile Model (mDP)
Planning ¥  Proposed Grading Model {mGR-F)

Plats & Survews ¥ Erosion & Sediment Control Model {mES)

14. On the Drainage Area Map menu, select the TcPath feature from the Hydrology
group.

Drainage Area Ma H

OpenSpace  Pavement  Commercial Residential “Wetland ‘Woods Brush  Water | Hydrology Labels

Drainagedrea
PoI

Notice the MicroStation symbology is set automatically and the Place Smartline tool is launched.
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15. Place a Tc path line in the file and reset.

16. Change the drawing scale to 1”=20".

MDSHA i
Menus | Scale  IDS Toaolbosx
Display Current Scale |

Mektric
Architectural P 1"=30
Full Scale {1"=1") 1" =40

17. Once again select the TcPath feature and place another smartline.

Notice that the Tc path line scales automatically.

Drawing Scale and Cells
Cell features respond to the drawing scale in the same way.

18. Select the POI feature from the Hydrology group.

Drainage Area Map Model {

Openspace  Pavement Commercial Residential  Wetland  Woods  Brush  WYater | Hydrology  Labels

Again notice that the symbology is set as well as the Place Cell command.
19. Place an instance of the cell and then reset.
20. Change the drawing scale.

21. Place another instance of the POI feature and reset.

Drainagefrea

2]
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Chapter 4: Reference Files

Lesson Objectives

In this lesson, we will explore MicroStation’s reference file capability to compose a plan sheet. In this
chapter, the topics covered include:

e Reference File Concepts
e Coincident reference files
e Saved view references

e Live nested references

e Layout Files

Reference File Concepts

The basic concept of referencing has not changed between V7 and V8, although a user’s options have
been expanded through the use of MicroStation V8.

Not only can version 7 files may be referenced to V8 drawings, AutoCAD DWG and DXF files may also be
referenced.

Additionally, there is no longer a 2D/3D limitation. 3D reference files may be referenced to 2D design
files.

These expanded options as well as the expanded level capability should greatly reduce the need to copy
elements from other drawings into your drawing for overlaying or printing.

The SHA CAD Standards do allow for copying of text from reference files to border sheets where
necessary. Discretion should be used when using this workflow.

There are two ways to attach references in MicroStation V8:

¢ Coincident and Coincident-World - this method is appropriate for Models because the
coordinates in the files will always be aligned properly. The coordinates of the referenced model,
and optionally its Global Origin (Coincident-World), are aligned with those of the active model,
without any rotation, scaling or offset.

e Standard or Saved Views — this method is appropriate for Borders and Design Details.
Referenced models may be rotated or scaled as needed.

Save Relative Path

When selecting the file to be referenced, the Save Relative Path should ALWAYS be toggled ON. This
setting not only promotes the portability of the project working directory but is critical for ProjectWise
integration.

4-1
oIS/2004 SHA DS

Integrated Design System



Chapter 4: Reference Files

Attach Reference

File Directary

Files:

| mT 0-c01_training. dan

Directonies:
C:ATrainingChapterdh,

a0 -waE DG

mHD-0000_training. dan
mT 0-c01_training. dan

mid T-EQ00D_training. dan
pHD-PO0T_training. dgn
pHO-PO0Z_training. dgn
pHO-PO03_training. dgn
pHO-PO04_training.dgn
pHO-PO05_training. dgn
wLA-0000_training. dgn

Lizt Files of Type:
icroStation DGM Files [*.

W Save Relative Path

= 2
[ Training
= Chapterd

Dirives:

IEE:

Cancel |

Attaching a Reference File Coincidently

Coincident reference file attachments are typically used for situations such as; attaching the right-of-way
model to the highway design model or attaching the existing topography file to the drainage design

model.

The workflow for attaching a reference file by using the Coincident method would be as follows:

1. From the MicroStation File menu, choose Reference, which opens the Reference File dialog

box.

2. From the Reference File dialog’s Tools pull-down, select Attach or press the Attach
Reference icon on the Reference File dialog.

Browse to and select the CAD drawing to be referenced.

4, Set the desired reference file settings.

Attach the reference.

Coincident Reference File Settings
When attaching a reference file coincidently, the reference file attachment settings are crucial to the SHA

workflow.

SHA_V8_0003
6/5/2004
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Attach Refere

File Mame:  mTO-201_training. dgn
Full Path:  C:ATrainingsChapterdmTO-c01_training. dgn

todel: |Default |
Logical Hame: |
D' ezcription: |
Crientation:
M ame | Dezcription -
Coincident Aligred with Master File
I:Z-:niru::in:lent -World  Global Origin aligned with kaster File
Top Standard Wiew
Bottom Standard Wiew
Left Standard Wiew j

Scale [MasterRef] I'I.EIEIEIEIEI[ : I'I.EIEIEIEIEI[ ¥ True Scale

Mested Attachmentz:  Live Mesting "l Depth: |'I

¥ | Dizplay Faster Beferences

| ] I Cancel I Options... |

Model

Within the current SHA workflow, the Model will be Default. The exception may be if the user decides to
use the model workflow defined later in this chapter.

Logical Name

The Logical Name is an optional field unless the user references the same model more than once. In that
case MicroStation requires a Logical Name in order to “keep track” of the references.

Description
The Description is an optional field.
Orientation

SHA has decided to attach reference files using the Coincident-World orientation. Coincident-World
takes into account the DGN files' Global Origins as well as their design plane coordinates. This assists in
correctly referencing V7 files into V8 files.

The SHA V8 workspace will default to Coincident-World when attaching a reference.
Scale

Typically when attaching coincident reference files, the scale will be set as 1:1.
True Scale

The True Scale setting should be toggled ON. This setting is so that references will adjust to the working
units and resolution of the model to which they are being attached.

Nested Attachments
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There are 3 options available for Nested Attachments.

P Mo Mesting
Live Mesting
Copy Attachments

¢ No Nesting - this option will reference only the file (or model) selected. Any file referenced to
that file will be ignored.

¢ Live Nesting — this option, along with the depth option, will maintain the hierarchical structure
of any nested references when attaching the parent reference to a model. This will be explained
in greater detail later in the chapter.

¢ Copy Attachments — this option, along with the depth option, operates as the nested reference
option in V7 did. Any nested references will be copied as a reference.

SHA Border

Different Divisions within SHA may use different border files, or at least require different title block
information. The new CAD Standards have combined all of the D size (22" x 34”) borders into one design
file named xBL-22x34.dgn.

Saved views have been created to segregate the information displayed by each division.

S
%4}:] > E,E,I |£iew: 'I"I

M ame | Description -
Drainage HHD Border
Facilities Q0 Border
TS TEDD ITS Sheet Barder
[ndex Index of Sheets
Landzzape LAD Barder
Lighting TEDD Lighting Sheet Barder

HOD Border

— Apply Options

[T Window:  Aspect Fatio v|
¥ Camera Position

¥ View Altibutes ¥ Levels
[T ClipYaolume [T Reference Settings
Cloze | Apply

These Saved Views can be used to quickly and easily attach the correct SHA Border to a display.

Attaching a Reference File Using Saved Views

The workflow for attaching a reference file by using the Saved View method is identical to the Coincident
method with the following exceptions:
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Plan sheets should be worked on in a rotated Top View. Rotate the MicroStation view window

so that the border is attached at a 0 degree angle.

Instead of choosing “Coincident-World” in the Orientation list box, choose the named saved view

you would like to attach.

In the Scale (Master:Reference) fields, define the scale ratio.

Place the border where you would like it to be in the file.

Attach Reference Settings

File Mame:  =BL-Z2%34.dgn
Full Path: .. SdanhBordershsBL-22%34.dgn

Model: [Default

Logical Marme: | Drainage

Description: | HHD Border

rientatian:

I ame | Dezcription

Shucture QBD Border
A oadway HOD Border
[erainage HHD! Barder

Facilitiez 20k Border
ITS TEDD ITS Sheet Barder
Haen Crozs Sechon Barder

Scale (MasterFef) [50.00000 : | 1.000000

¥ True Scale

Mested Attachments Mo Mesting Vl

¥ | Dizplay Faster Beferences

[emth; I'I_

| ok I Cancel I Optionz... |

Layout Files using Live Nested References

Nested reference files are not new to MicroStation. What is new is the advent of “Live” Nesting.

The live nesting capability in MicroStation V8 should greatly improve the workflow for creating plan
sheets. The Layout File will be used as a Motif for the plan sheets. This is a variation of the motif
concept used by GEOPAK, whereby a single file (i.e. the Motif) is used to maintain the set of all reference
files that should be referenced to a given subset of plan sheet files (e.g. Roadway Plans).

In the SHA workflow, each plan sheet file then contains only two reference files: the Base Linen
("Border”) file and the Layout file.
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plan sheet plan sheat plan sheet plan sheet plan sheet
P01 POz P03 FO4 I
** * ‘ 4 * ,‘ Direct Reference

Rgsjfndge Base Linen Layout File
DEPth=1 Bl sl A

|
! Direct Reference
4 i A A }

madel file madel file model file mode file maclel file
max MK M X mAa X max

The Layout file not only maintains the reference files for the other plan sheets, but it also shows the
coverage of the plan sheets relative to the design models. The file should only contain match lines,
border shapes, and reference file clipping shapes, along with any user notes. In this manner the
Layout file serves as an index to the set of plan sheets it represents.

Note: A separate Layout file should be created for each subset of plan sheets. Likewise for sheets at
multiple scales. Recommended files names might be:

xLA-pHDP_md43.dgn for Roadway Plans (pHD-P)
xLA-pLDP_md43.dgn for Landscaping Plans (pLD-P)
xLA-pESP_md43.dgn for Erosion and Sediment Control Plans (pES-P)
xLA-pMTP_md43.dgn for MOT Plans (pMT-P)

Notice that Layout files are grouped along with Base Linens in the Miscellaneous (X) File Group
due to the distinctive way in which they are used.

Layout files will attach all Model files that will ultimately be shown in the corresponding plan sheets.
Once a layout file has been created, it may be useful to copy that file as a starting point for creating
Layout files for other plan sheets. The LA file is typically created by hand, although InRoads and GEOPAK
also contain Plan and Profile Generating tools that automate this process. These tools are most effective
on jobs requiring several plan sheets evenly spaced along a single alignment.

When the Layout file is attached to the plan sheet, set the Nested Attachments setting to Live
Nesting with a Depth of 1. (Also, Scale should always be 1:1 when referencing Model files!)

Scale [MasterRef] I'I.EIEIEIEIEI[ : I'I.EIEIEIEIEI[ ¥ True Scale

v| gepthD

Optionz... |

o

@ttachments:? Live Mesting

¥ | Dizplay Fiaster Heferences
| ] 4 I

“Nesting of Depth 1” means that the active file will show the elements in the attached reference file, as
well as the elements in the reference file’s reference files. A Depth of 2 would display the reference file's
reference files’ reference files, and so on. (Imagine an ever-expanding tree diagram.)

Cancel I
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Note: You should NEVER use a nested depth greater than 1. Because most Model files are referenced
to each other, you will quickly have the same file referenced into your plan sheet multiple times.

Hands-on Exercise: Composing Plan Sheets

In this exercise, we will create a series of plan sheets using the Layout File (xLA) as a Motif for the plan
sheets.

Creating the layout file
First we are going to create the layout file.

1. Use the File Naming Wizard to create a layout model in the folder
C:\Training\Chapter4\. For the ProjectID specification, type training.

What is the name of the newly created layout file?

A Cool Tool: Remember the Open first sheet upon creation toggle? If you toggle this ON when
you create the new file, MicroStation will open this file for you automatically upon
creation.

2. Press Accept to create the file.

Attaching the model files to the layout file

Next, we are going to reference the files that we want to show on our plan sheets. At this point we are
going to reference two files, the highway design model and the existing utility model.

3. Access the Reference File dialog either from the File pull-down or by selecting the
Reference icon on the Primary Tools toolbox.

Primary H
ALHEacose

4. Select the Attach Reference tool by either selecting Tools>Attach from the
References dialog or by selecting the Attach Reference icon.

EREferences (0 of 0 unigue, 0 displayed)
EREferences {0 of 0 unique, 0 displ Tools  Settings

Tools  Settings ;
e [ER Bl &
K Slot | File N Mod .
| éktach URL... el ot | File Name [ Mo ‘l.ﬁ.tta-:h Reference [‘I
Mekark — OR

A Cool Tool: Remember, there is a third way to access the Attach tool. Right-click in the reference
file list area.

5. Browse to the highway design model (C:\Training\Chapter4\mHD-
0000_training.dgn)
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6. Make sure the Save Relative Path is toggled ON.

| |
Lizt Files of Type: Dirives

w05 ation DGM Files [F.dan] "l |El C:

ve Relative Path

7. Select the OK button to proceed to the next step.

8. Check the Attach Reference Settings dialog to ensure the settings match the dialog
shown below:

Attach Refere

File Mame:  mHD-0000_training. dan
Full Fath: . ATraininghChapterdsmHD-0000_training. dge

Model: IDefauIt =l
Logical Marme: |
Description: |
Orientation:
I ame | Dezcription |
Coincident Aligred with b aster File

E-:niru::iderut -wiorld  Global Origin aligned with Mazter File

Top Standard Wiew

Scale [Master:Fef] |1.EIEIEIEIEI[ : |1.EIEIEIEIEI[ ¥ True Scale

Mested Attachmentz: Mo Mesting v| [epth; I'I

¥ | Display Faster Feferenceas

| Ok I Cancel I Optiaons... |

Note: Although we did not specify a Logical Name or Description in this exercise, on a real project,
those fields would be specified at this time if desired.

9. Fit the MicroStation view to see the highway desigh model attached.

10. Repeat steps 4-9 to reference the utility model (C:\Training\Chapter4\muUT-
E000_training.dgn)

In the next few sections, we are going to set up the layout file with border shapes, match lines and
clipping shapes. This will help us identify our sheet limits and set up shapes to use as reference file
clipping boundaries.
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Set the Sheet Scale

In the next step, we are going to place border shapes. These border shapes are actually MicroStation
cells. To ensure that these cells are placed at the right scale, we need to set the correct scale for our final
plan sheets. We are going to use a scale of 1”=50".

11. Check the MicroStation title bar. What is the current scale?

Scale: Full (1" =1")

HLA-0000_kraining.dgn (2D - ¥8 DGN) - MicroStation ¥8.1

12. If necessary, change the drawing scale by selecting Scale>Civil>1"=50" from the IDS
Main Menu.

MDSH; =
Menus | Scale  IDS Toolbox

Display Current Scale |

Mektric
Architectural
Full Scale (1"=1")

Apply Drawing Scale

Tarmmem P maime e ale

13. Check the MicroStation title bar again to confirm that it reads Scale: 1"=50".

Laying Out Border Shapes
Once we have the appropriate references attached, the next step is to lay out the border shapes.

Border shapes are designed to assist the user in determining plan sheet coverage, where to put match
lines and then to position the border reference files for each plan sheet.

On the Sheet Layout menu, there are two Border Shape features.

Border Shape — Full This feature places a shape that represents the interior drawing are on a
plan sheet from the inside of the border and around the title block.

Border Shape — Truncated This feature places a shape similar to the Border Shape — Full except
that it also allows for notes to be placed on the right edge of the sheets.

Border Shape — Full Border Shape - Truncated
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14. Call the Layout File (xLA) menu from the Menus pull down on the IDS Main Menu.

MDS ]
Menus  Scale  IDS Toolbox

o Bridge
Drainage k
Landscape
Mapping
Planning
Plats & Survews
Roadway
Traffic

v v v v

Layouk File (xLA)

Roadway Plan Set 3
Traffic Plan Set r
Documents g
Displays 3
Miscelaneous »

15. Decide on a starting point for laying out the border shapes. For instance, if there is an
intersection in the design, you may want to make sure it will be centered on a border
shape, and then place the adjacent shapes accordingly.

16. Select either of the Border Shape features from the Sheet Layout menu.
17. Select a data point to identify the location of the shape along the roadway.
This feature will allow the user to specify the rotation angle of the shape with a data point.

18. Move the cursor to specify the appropriate angle of the shape and select a data point.

Note: If you would like the shape to be placed without a rotation angle, right-click.

19. Move the cursor to the location of the next sheet and repeat steps 15-16 along the entire
roadway.

Generating Match Lines

Next we are going to place match lines for our plan sheets. Match lines represent the extents of coverage
for a given plan sheet. They show where one plan sheet ends and another begins. Match lines are
drawn perpendicularly to the alignment and should appear at major stations.

For 50-scale plans, match lines are typically spaced at 1200-1600 ft intervals.

For 30-scale plans, match lines are typically spaced at 800-1000 ft intervals.

For 20-scale plans, match lines are typically spaced at 450-550 ft intervals.
20. Activate the Match Line feature from the Layout File menu.

Note that the Place SmartLine command is automatically activated, along with the proper symbology.
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21. At the major station where the match line will go, trace the major tick by snapping to
its end points with the SmartLine tool. This sets the angle of the match line so that it is
perpendicular to the alignment.

A Cool Tool: AccuDraw may help tremendously in placing match lines by rotating the compass to the
angle of the station tick.

22. Next, activate the Extend Line tool in the Modify Element toolbox, and lengthen the
match line in both directions.

23. Repeat this process at even intervals until the extents of all plan sheets have been
defined.

Note: Remember, for intersecting roadways you may want to generate match lines for those roadways
as well.

Creating Clipping Boundary Shapes

Clipping boundaries restrict portions of a reference file from appearing in the active file. In the case of
plan sheets, these are used to establish margins between the edge of the visible design model and the
interior plan border.

Note: A closed shape element can be designated as the clipping boundary. Later on, if the size or
shape of the element is modified, the clipping boundary automatically updates to reflect the
changes!

24. Activate the Clipping Boundary feature from the Layout File menu.
Note that the Place Shape command is activated along with the correct symbology.

25. Again starting with the first plan sheet, snap to the end of the first match line and begin
to outline a shape to represent the edge of the visible model in the plan sheet. Be sure
to trace both match lines as part of the final shape.

26. Repeat step 25 to create a clipping shape for each plan sheet.

Note: Remember, for intersecting roadways you may want to generate clipping boundary shapes for
those roadways as well.

Creating the First Plan Sheet

In this section, we are going to create our first plan sheet. Once we have the first sheet set up, we are
going to use the File Naming Wizard to quickly create the remaining plan sheets by using the first plan
sheet as the seed file.

27. Access the File Naming Wizard.
28. On the File Setup tab, set the directory to C:\Training\Chapter4\

29. On the Build File Name tab, either use the Select By Description toggle to create a
Roadway Plan Sheet or manually build the file name by specifying the Group,
Discipline and Sheet Type.

30. Specify training as the Project ID.
31. Set the Starting Sequence # to 01.

What is the name of the newly created plan sheet file?
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32. Press Accept to create the file.

33. If necessary, manually open the plan sheet you just created.

Referencing the Layout File to the Plan Sheet

In this section we are going to reference the layout file to our plan sheet using Live Nesting.

34. Access the Attach Reference tool from the reference file dialog.
35. Browse to the layout file (C:\Training\Chapter4\xLA-0000_training.dgn).

36. Make sure the Save Relative Path is toggled ON.

37. Press the OK button.

We are going to use the Coincident — World attachment with a 1:1 True Scale. However, this time

we want to use Live Nesting with a Depth of 1.

38. Set the Nested Attachments option to Live Nesting and the Depth to 1.

Attach Refere

File Mame:  =LA-0000_training. dgn

Full Path:  C:ATrainingtChapterdwLA-0000_training. dgn

Model: [Default

=

Logical Mame: |

Dezcrption: |

Origntation:

M ame | Description |
Coincident Aligned with b aster File
E-:niru::ider‘ut -wiorld  Global Origin aligned with M azter File

Origin 0 Origin

Top Standard Wiew

Scale (MasterFef) [1.000000 : [1.000000 W True Scale

Mested Attachments:  Live Mesting

"l Depth: I'I_

¥ | Dizplay Faster Beferences

| (1] 4 I Cancel I

Optionz... |

39. Press the OK button.
40. Fit the MicroStation View.

Notice that although the Reference File dialog shows only the layout file being attached, we still see the
information from the highway design model and the utility model. This is the result of live nesting.

Adding the Border File

Remember the border file we created in Chapter 2? We are going to use that file in this exercise.
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The next step is to reference our previously created border sheet into our plan sheet via a Saved View.

41. Access the Attach Reference tool from the reference file dialog.

42. Browse to the border sheet (C:\Training\Chapter2\xBL-0000_training.dgn).

43. Make sure the Save Relative Path is toggled ON.

44, Press the OK button.
This time, instead of attaching the file with the Coincident - World option, we are going to attach by

Saved View.

45. In the Orientation option portion of the Attach Reference Settings dialog, select the
appropriate Saved View. For example, Highway Design would select the Roadway view,
Highway Hydraulics the Drainage view, etc.

46. To set the Scale (Master:Ref) field to reflect our 1"=50" scale plan sheets type 50 in
the first scale field and hit the 748 key on your keyboard.

47. Ensure the True Scale toggle is ON.
The dialog should look similar to the one shown below; however, you may have a different Saved View

selected.

Attach Refer

File Mame: =BL-0000_md43.dgn
Full Path:  C:ATrainingtChapter2y«BL-0000_md43.dgn
todel; |Default =]

Logical Mame: |Hnadway
Diezcription: IHDD Border

Drientation:

Description
HOD Barder

HHD Border J
Q0K Border

LAD Border

TEDD ITS Sheet Border

Index of Sheets j

Scale (MasterFef) [50.00000 : |.000000 B Tre Scale

Mested Attachmentz: Mo Mesting "l [repth; I'I

¥ | Dizplay Faster Beferences

| (1] 4 I Cancel I Optionz... |

48. Press the OK button.
Since we are not referencing this file coincidently, MicroStation allows us to specify the location of our

Saved View reference.

SHA_V8_0003
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49.

Select a location for the border sheet and data point to place the reference. At this
point we are not concerned about the exact location of the border. We will take care of
that later.

Creating the Remainder of the Plan Sheets

Now that we have the first plan sheet set up, we can create the remainder of the plan sheets by using
the first sheet as a seed file.

50.

51.
52.

Look at the boundary shapes and take note of how many total plan sheets you will have
(probably 5).

Access the File Naming Wizard.
On the File Setup tab, set the directory to C:\Training\Chapter4\

This time we are going to Override the Default Seed File and instead use the first plan sheet as the seed
file. Again, this will save us time because the live nested reference files (highway design model and utility
model) as well as the border sheet will be pre-attached to each sheet.

53.

54.

55.

56.

57.
58.
59.

Toggle the Override Default Seed File option ON and browse to
C:\Training\Chapter4\pHD-P001_training.dgn.

On the Build File Name tab, either use the Select By Description toggle to create a
Roadway Plan Sheet or manually build the file name by specifying the Group,
Discipline and Sheet Type.

Specify training as the Project ID.

Set the Starting Sequence # to 02 Remember, the sequence number of the
previously created plan sheet was 01.

Make sure the Open first sheet upon creation option is toggled off.
Set the # Sheets to 4.

Press Accept to create the files.

Clipping the Plan Sheets

In this section we are going to clip the plan sheets. Due to time constraints we are only going to do the
first one, however the process would be identical to complete the set.

60.

61.
62.
63.
64.

65.
66.
67.
68.

If necessary, open the first plan sheet (C:\Training\Chapter4\pHD-
P001_training.dgn).

Access the Reference File dialog.
Highlight the border sheet (xBL-0000_training.dgn).
Select the Move reference tool.

Move the border reference to the first border shape by using the lower left corner of the
inside border line as “reference” point.

With the border reference highlighted, select the Rotate reference tool.
Check the Tool Settings dialog to ensure the Method is set to By Points.
Rotate the reference so that it lines up with the border shape.

Rotate the view so that the sheet aligns with the view. Remember, there are Rotate
View tools available under the IDS Toolbox menu.

6/5/2004
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MDS| E
Menus Scale | IDS Toolbox

File Maming ‘Wizard

DR Tools

TEDD Apps

Sign Toal

gInt Bore Log k

InfoSnap
InRoads

Raotake Yiews By Poinks

Rokake Yiew By Element

69. In the Reference File dialog, highlight the layout file (xLA-0000_training.dgn).

70. Select the Clip Boundary tool and clip the layout reference using the clipping shape
we placed previously.

At this point you would want to turn off the display of the clipping and border shapes for the layout file.
71. Save your MicroStation settings before exiting the file.

Adding a Reference to the Layout File

In this section, we are going to add a reference to the layout file and see how the live nesting propagates
the reference attachment through all our sheets.

72. Open the layout file (xLA-0000_training.dgn).

73. Attach the composite topography model (mTO-c01_training.dgn) using Coincident —
World attachment at a 1:1 True Scale.

74. Open the first plan sheet to verify that the topo information is now seen in the plan
sheet.
Adjusting the Clipping Shape

In this section, we are going to adjust a clipping shape in the layout file and see how the change is
reflected in the plan sheet.

75. Open the layout file (xLA-0000_training.dgn).

76. Use the Modify Element tool in MicroStation to modify the clipping shape for the first
plan sheet. Make a significant enough change that you will be able to notice it.

77. Open the first plan sheet to verify that the clipping boundary has changed based on the
clipping shape modification.
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Chapter 5: Plotting

Lesson Objectives

In this lesson, you will use MicroStation and IPLOT to print preview a contract document. In this chapter,
the topics covered include:

e Plotting using MicroStation

e Plotting using Interplot

Plotting at SHA

Bentley’s InterPlot is commonly used at SHA to plot contract drawings. However, many SHA consultants
do not use IPLOT. Consequently, when electronic files are submitted, SHA is often at a loss to reproduce
the plots as provided by the consultant.

Therefore, standard pen tables and plot drivers have been created to allow for identical plots to be
created using either IPLOT or standard MicroStation plotting. These plotting files have been set up to
ensure that line styles and line thicknesses will be consistent, for both Full size (34x22) and true Half size
(17x11) plots.

Plot Sizes

Depending on project needs, a specific size may be required for plotting.

Large-format Plotters: A roll-feed machine (typically 36-inch rolls) for the production of larger
drawings could be inkjet or thermal. These print a standard-size 34 x 22-inch sheet from MicroStation for
all construction documents and plans. Other sizes are used for large wall-display boards.

IPLOT pen table | MicroStation plot driver
B/W FullMono.pen FullMono.plt

Color FullColor.pen FullColor.plt

Standard-format LaserJet and Inkjet Printers: Half-size plans are often required (17 x 11-inch,
tabloid). This is also used in the production of plats, smaller drawings, and related documents.

IPLOT pen table | MicroStation plot driver
B/W HalfMono.pen HalfMono.plt
Color HalfColor.pen HalfColor.plt

CAD operators in each Office and Division have customized the printers and plotters. The server within
each Division controls and queues plot jobs to these devices.
Colors

As can be seen from the tables above, different pen tables and plot drivers have been created for plotting
in color vs. monochrome (black & white).

5-1
004 DS

Integrated Design System



Chapter 5: Plotting

FullColor / HalfColor: These files have been configured to use the RGB values of the attached color
table. No changes will be made to modify colors. These files should be used when plotting wall displays
or other full color documents where you want to use all the colors as shown in the file.

FullMono / HalfMono: These files should be used for plotting contract documents. Most colors will
plot as black, with exceptions for gray scale and certain color values, all of which are contained on the
bottom two rows, as follows:

232 Gray 10%
>33 Gray 20%
234 Gray 30% for Shading Fils Edt
Gray | 235 Gray 40%
Scale | 236 Gray 50% for Linework
237 Gray 60%
238 Gray 70%
239 Gray 80%
240 SHA Logo Orange
241 SHA Logo Blue
242 Orange
243 Yellow
True | 244 Blue
Color | 246 Light Green for Shading
247 Green Lines
252 Light Red for Shading B | Cancel |
253 Red Lines
254 White to block items out

Note on Mono: If you are using one of the Mono files to plot to a black and white printer or plotter, the
“True Color” values in the bottom row will plot as corresponding shades of gray.

Line Weights and Thicknesses

Aside from the new level names, one of the biggest differences in SHA’s new V8 CAD Standards is the
establishment of plotted line thicknesses. In the past, the line thicknesses that appeared on plots were
often at the mercy of the plotter. SHA has attempted to correct this by hard coding the plotted line
thicknesses into the new MicroStation plot drivers and IPLOT pen tables. Furthermore, the thicknesses
associated with each line weight have been changed.

Line weights 0-12 have been re-defined to correspond with the thicknesses of the Koh-I-Nor drafting
pens of old. The result is that the final plots more closely match that which you see on the screen.
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OLD NEW

N EORM oA~ MWN O

Advantages:

e Single step increments between line weights have discernable differences when plotted. (For
instance, there is currently not much difference between weights 3 and 4)

e Plots more closely resemble what you see on the screen.

e Hard coded thicknesses should be consistent across plotters.

Rule of Thumb: Generally speaking, line weights plot roughly twice as thick as before. Therefore, when
in doubt, use a line weight that is half that of what you would have used previously.

For example: instead of 12 for a bold line, use 6

Hands On Exercise — Using IPLOT
1. Open the file C:\Training\Chapter5\weight compare.dgn.

2. From the MicroStation File menu, select IPLOT.
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3.

4.

5.

Set your desired Color Table and Pen Table by choosing IPLOT>File>Select Plotting
Files.

EIPLDT - Select Ploktting Files -10] x|

Color Table: |pace"xF'r-:uiects'xSH.-“-‘-.".EEIEIfi_standards"-.data'aEI-::rM dSHA. bl |
Fen T able l YProjectzWSHAM2004_standardzMtables\PenFullColor. pen |

Bendenng Attibutes: rm o

Browse to and attach the S:\CADD\Workspace\Standards\MDSHA V8
01\tables\Pen\FullMono.pen table.

Close the Pen Table window and click Preview.

Note: You may need to check your Display>Attributes to make sure all setting are correct, for

instance, ensuring that Fill is turned on.

8.

WITHOUT clicking Print, close the Preview window.

Select the HalfMono.pen table and see the difference in line thicknesses. Lines in
HalfMono should appear half as thick as the lines using FullMono.

When finished, exit IPLOT.

Hands On Exercise - Using Standard MicroStation Plotting

If InterPlot is not available, plots may be generated from standard MicroStation. This is particularly
useful for creating representative prints on 8'2x11 or 11x17 laser jet printers, which are not always
configured for IPLOT.

Now examine the MicroStation plotter drivers included in the SHA CAD Standards to assist in the plotting
process. Results should be identical to that of the pen tables examined through IPLOT.

1.
2.
3.

Select File>Print.
In the Printing window, select File>Bentley Driver.

Browse to and select the file S:\CADD\Workspace\Standards\MDSHA V8
01\plotdrv\FullMono.plt

If necessary, select the Pen Table S:\CADD\Workspace\Standards\MDSHA V8
01\tables\Pen\name_sub.tbl. This file performs various text substitutions.

Click the Preview button.
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Chapter 6: Tools

Lesson Objectives

In this lesson, you will learn about the customized tools that have been integrated into the SHA CAD
Standards. In this chapter, the topics covered include:

e MCPC (More Cogo Plotting Commands)

MCPC (More Cogo Plotting Commands)

The Plats and Surveys Division uses the MCPC application to extend the functionality of the InRoads
software. The application was developed by Rummel, Klepper & Kahl, LLP.

Loading MCPC
The MCPC application may be loaded inside MicroStation by two methods.

Method 1 — Loading the MDL Application

Open the MicroStation key-in window by selecting Utilities>Key-in from the MicroStation pull down
menu.

Key in mdl load mcpc and either hit the ENTER key on the keyboard or select the Run Key-in button
on the Key-in window.

4
oo nccd o F=-

Method 2 — IDS Main Menu
From the IDS Main Menu, select MCPC>Load.

MDSHA ﬂ
Merus  Scale | IDS Toolbosx

Feature Search |

File: Marming YWizard

DR Tools Help
TECD Apps |

MCPC Help

Specific information about the use of MCPC may be found in the MCPC Users Guide. A link to the MCPC
Users Guide is also available from the IDS Toolbox by selecting MCPC>Help.
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Chapter 7: InRoads

Lesson Objectives

In this lesson, you will learn about some of the new features in InRoads 8.4 as they relate to Surfaces
and Coordinate Geometry. In this chapter, the topics covered include:

e Loading InRoads through the IDS toolbox
¢ New InRoads 8.4 functionality

e  Processing ICS files

Loading InRoads Through the IDS Toolbox
InRoads may be loaded by selecting InRoads from the IDS Main Menu.

MDS 5
Merus  Scale | IDS Toolbox

T Feature Search
File: Maring Wizard
MCPC F
DR Tools
TEDD Apps
Sign Taal
glnt Bore Log g

InfoSnap

AutaTurn

Note: InRoads must be installed on the local machine in order to load InRoads from the IDS
Toolbox.

New InRoads 8.4 Functionality

Although there are many enhancements InRoads 8.4, the following is a list of enhancements that apply
specifically to the Surface and Geometry functions.

Cogo Buffer in the InRoads Explorer Window
The Cogo Buffer will now display the point information in the explorer window.
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mlnﬂnads _I_l- O EI
File Surface Geometry Ewaluation Modeler Drafting Tool: Help |
Mame | Skvle | Morthing | Easking | Elervation |
-4 Caga BuFfer |l |51 defaut 11815.81 1163857 0,00
I 2 default 11695.00 1243385 0.00
------ o 3 default 12689.64 1290203 0,00
------ 3 4 default 13113.94  13614.45 0,00
e
""" t: 4 ?‘:5 default  13015.50 13957.14 0,00
...... g e
R ;I .0 default  13314.21 14683, 16 0.00
£ Geometry |‘ Typical Sectio 4 | >|

Generates various reporks

Single Entry Scale Factor
Scale factors can now be set with a single entry and locked for text, cell and line style.

'r“ Options ;IEIEI

Frecizion | General | Initz and Format I G eametry I Tolerances I
Affixes Factors | Substitution I Access Control I R il I

Text Scale Factar: |5|:|_ Qoon Help

Cell Scale Factor: |5|:|_|:||:||:||:| ‘ o)
Line Style Scale Factor: |5|:|_|:||:||:||:|

Drafting Tools Add-in

Drafting tools for placing, updating and moving notes in plan, profile and cross sections are available. The
Drawing Production Application Add-in is launched by default as the Drafting menu on the InRoads

Explorer menu.

mInRuads

File Surface Geomety  Ewaluation  Modeler | Drafting Tool: Help

=10l x|

Nam & Place Plan Note I L
F-& Geometry Projects || % #* & Place Profile Note
E Default Edn |25} Place Cross Section Mate
E‘" 7@ Place Alignment Interzection Mote
e
T EEQD Buffer £ Update Plan Mote
:f;h: ; EE Update Profile Mate
P f;.: - ;I ﬁ IJpdate Crozz Section Hote
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Chapter 7: InRoads

Application Add-in Dialog Enhancement

The Application Add-in dialog has been enhanced to display the location in the product menu of the
selected Add-In and specifies which product(s) supports the selected Add-In. The icons represent their
respective products. An “X” in the column specifies the selected command exists in that product. A “-"
specifies the selected Add-In does not exist in that product.

mnpplicatiun Add-i =101

Awailable: 0k |
: Create/Edit Companents Add-In ;I

: Crozs Section Report Add-ln Cancel |
[ ]Da Translator Add-n J Hel

[ |DBGIS Translator Addn Ll

Dezign Checks Add-n
Drainage Structure Analyzer Add-n
Drawing Production Add-ln
Dirive Roadway Add-n
[ |Dive Foaduay addin. =l

— Description

The Drawing Production Add-ln provides drafting toolz for placing and manipulating notes on plan, profile
and cross zection views.

Carnmand [ [ o | o [ B0 B [ ad | P =
Diraftingr Place Plan Mate * >< * * * ><

Drraftingr Place Profile Maote

Dirafting: Place Cross Section Maote
Draftings Place Alignment Intersection Maote
Drraftingr U pdate Plan Mate

Drraftingy U pdate Profile Maote

Dirafting: Update Cross Section Maote
Drafting: Move Mote

OB MMM
i o ot e
Mo MMM M
W MM M
OB MMM
oo M M
UMM MM

[

Processing ICS Files

Survey information is processed using the Wineti software. The resulting ICS (interactive coordinate-
geometry subsystem) file may then be imported into InRoads to create the Coordinate Geometry
information (*.alg file).

Before importing the ICS file, here are some things to keep in mind:

Create or open an InRoads geometry project — InRoads imports the ICS information into the active
InRoads geometry project.

Open the appropriate style file — InRoads will place the elements in the MicroStation DGN based on
the wysiwyg file that is open. Using a wysiwyg file other than the one created for Plats and Surveys may
result in elements being displayed incorrectly.

Check the drawing scale — InRoads will scale text, cell, and linestyles based on the Scale Factors
found under Tools>Options>Factors.

Check the Write lock — If you would like the elements to be written into the MicroStation design file,
the Write lock must be ON.
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Chapter 7: InRoads

Hands On Exercise — Importing an ICS File

In this exercise, an ICS file will be imported into InRoads and plotted into a topography model file using
the Plats and Surveys wysiwyg.ini file to ensure that the SHA standard level names are used. The ICS file
we will be using exists in the folder C:\Training\Survey\I-270 and is named 1i270.ics.

Creating a New Design File to Display the ICS information

1. Using the File Naming Wizard, create a new MicroStation model file for survey topo
for I-270 in the folder C:\Training\Survey\I-270.

What is the name of the newly created topo model file?

2. Open the new file if necessary.

Launching InRoads
1. Launch InRoads by selecting InRoads from the IDS Toolbox.

MDS Ed|
Menus  Scale | IDS Toolbox

T Feature Search
File: Marming YWizard
MCPC F
DR Tools
TEDD Apps
Sign Tool
gInt Bore Log g

InfoSnap

AukaTurn ! |

Create an InRoads Geometry Project

In this section we will create a new geometry project name within InRoads memory. When the ICS file is
imported, a command within the ICS file will save the information within memory to an ALG file on the
hard drive. To help organize our project, will use the same name internally as the stored ALG file
(1i270).

1. Select the Geometry tab in the left pane of the InRoads Explorer dialog.

2. Right-click the Geometry Projects heading and select New... to create a new
Geometry Project.

7-4
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mInRuads _I_I- m| EI
File Swurface Geometry Ewaluation Modeler Drafting Tools Help |
<Urnameds r B BN Y s B
Geametry Proje. .. | Descripkion | File Marne | a]
o I 2= DeFault
[j= DEEM
Qpen, ..
Ackive, ..
1 Celete ol
£8 Surfaces 3
S Enpyal IKIpY | [
Creates a new surface, geomekry project, template library, roadway library or drainage File o

3. Name the Geometry Project 27i270. You may also supply a Description if desired.

Tnew =5 x]
Suface Geometry I Typizal Section LiI:urar_l,II Foadway LiI:urar_l,II

Type: I Gearnetny Project j Apply |

Name: [i270 Gies.. |
Cescription: | Hel

elp |
Style: | j

e Definition: I j

E istinig D escription
Drefault

4. Press Apply to create the project.

5. Press Close to close the New File dialog.

Open the Plats and Surveys Preference and Style files.
1. Select the Preferences tab in the left pane of the InRoads Explorer dialog.

Notice that both the Preference and Style files are set to the default InRoads delivered files located in
C:\Program Files\Bentley\Civil\data\. Importing the ICS file using the delivered InRoads style file
will cause the ICS information to be plotted incorrectly in the DGN file.

2. Right-click the default Style file and select Open...
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mInRuads ;IEIEI

File  Surface Geometry Ewaluation Modeler Drafting Toolz Help |

<Unnamed: - |@\ )”_?X| . - S'JJJ'E' .

=% Preferences

_H-‘-'- Roadways % Prefere

Fead-Only L
v Read-rite A
Details. ..

Save As...

3. Browse to S:\CADD\Workspace\Standards\MDSHA_V8_00\inroads.
4. Highlight p&s_wysiwyg.ini and press Open.

Fil= narne: Ip&s_wysiwyg_‘v"&ini

Filez of type: I Styles [%ini] j Cancel

Help

I

v

Right-click the default Preference file and select Open...
Browse to S:\CADD\Workspace\Standards\MDSHA_V8_00\inroads.
Highlight p&s__civil_V8.ini and press Open.

© N o U

Press Cancel to close the Open file dialog.

Check the Drawing Scale
1. From the InRoads Tools menu, select Options.

2. Select the Factors tab.
3. Set the Text, Cell and Line Style Scale Factors to 50.
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m Options ;IEIEI

Precizion | General | IInitz and Format I [Geometmy I Tolerances I
Lffiwes Factors | Subztitution I Azcess Control I R ail

Text Scale Factar: |5|:|.|:||:||:||:| —I Help | |

Cell Scale Factor: 500000 =

Lire Style Scale Factar: |5|:|_|:||:||:||:| J

4. Press Apply to apply the new scale factors.

5. Press Close to close the Options dialog.

A Cool Tool: The Global Scale Factors Add-In may be enabled from the Application Add-ins to add the
option to the Tools pulldown.

P application Add-ins - 0] x|

Aailable:

|:| GEOPAE, Translator Add-ln
5lobal Scale Factors Add-n

|:| Horizontal and Yertical Elements Add-n

Check the Write Lock
1. Ensure that the Write Lock is enabled in Pencil mode.

Processing the ICS File
1. From the InRoads File pulldown, select the Import>Geometry tool.

mInRuads

File Surface Geometry Ewaluation Modeler Drafting Tool: Help

e chbed | | 2 B
_: = Qpen... Cirl+0  —m—m—
Save *

S AI
ave Az

civil ini
E' Project Defaults... r—'n—l

Imnpaort g’ Surface...

B oo
ﬂ Template. ..

1 C:ATra. M-27081i270. alg

-

-

On the ICS tab, left click in the File Name field to enable the Browse button.
Browse to C:\Training\Survey\I-270
Highlight 1i270.ics and select Open.

v A WweN

Press Apply to start the import process.
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Review the Design File Elements
1. Fit the design file to see the newly plotted elements.

2. Open the Level Display dialog to see that all elements have been plotted on SHA standards
levels.
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